Loading paper and specialty media.................................40
  Setting the paper size and type.................................................................40
  Configuring Universal paper settings..........................................................40
  Loading the standard 250-sheet tray.........................................................40
  Loading the optional 250- or 550-sheet tray..............................................45
  Using the manual feeder............................................................................46
  Using the standard exit bin and paper stop...............................................47
  Linking and unlinking trays........................................................................48
    Linking trays...............................................................................................48
    Unlinking trays...........................................................................................48
    Assigning a custom paper type name to a tray........................................48

Paper and specialty media guide........................................50
  Paper guidelines.......................................................................................50
    Paper capacities.......................................................................................50
    Paper characteristics................................................................................50
    Unacceptable paper..................................................................................51
    Selecting paper ........................................................................................52
      Selecting preprinted forms and letterhead............................................52
  Storing paper..............................................................................................52
  Supported paper sizes, types, and weights.................................................53
    Paper sizes supported by the printer.......................................................53
    Paper types and weights supported by the printer...................................54

Printing.........................................................................................56
  Printing a document..................................................................................56
    Printing a document................................................................................56
  Printing on both sides of the paper............................................................57
    Printing on both sides of the paper........................................................57
    Printing on both sides of the paper manually........................................57
  Printing specialty documents......................................................................59
    Tips on using letterhead..........................................................................59
    Tips on using transparencies...................................................................60
    Tips on using envelopes..........................................................................60
    Tips on using labels................................................................................61
    Tips on using card stock.........................................................................61
    Printing a booklet (Windows).................................................................62
  Printing information pages.........................................................................62
    Printing the menu settings and network setup pages............................62
    Printing the print quality test pages.......................................................63
### Contents

- **Maintaining the printer** ................................................................. 84
  - Cleaning the exterior of the printer .................................................. 84
  - Storing supplies .............................................................................. 84
  - Checking the status of supplies ......................................................... 84
    - Checking the status of supplies from a network computer ............... 84
  - Ordering supplies ........................................................................... 85
    - Ordering toner cartridges ............................................................... 85
    - Ordering a photoconductor kit ......................................................... 86
  - Replacing supplies ......................................................................... 86
    - Replacing the toner cartridge ......................................................... 86
    - Replacing the photoconductor kit ................................................... 88
  - Moving the printer .......................................................................... 91
    - Before moving the printer .............................................................. 91
    - Moving the printer to another location ........................................... 91
    - Shipping the printer .................................................................... 92

- **Understanding printer menus** ..................................................... 66
  - Installing the Local Printer Settings Utility ....................................... 66
  - Using the Local Printer Settings Utility ............................................ 66
  - Using the Finishing menu .................................................................. 67
  - Paper menu ...................................................................................... 68
    - Default Source menu ...................................................................... 68
    - Size/Type menu .............................................................................. 68
    - Paper Texture menu ...................................................................... 70
    - Paper Weight menu ....................................................................... 72
    - Paper Loading menu ...................................................................... 73
    - Custom Types menu ....................................................................... 73
    - Universal Setup menu .................................................................... 74
  - Settings menu .................................................................................. 75
    - General Settings menu ................................................................. 75
    - Setup menu .................................................................................... 77
    - Finishing menu .............................................................................. 78
    - Quality menu ................................................................................. 80
    - PostScript menu ............................................................................ 81
    - PCL Emul menu .............................................................................. 81

- **Understanding printer menus** ..................................................... 66
Administrative support..............................................................................93
Finding advanced networking and administrator information.........................93
Restoring the factory default settings....................................................................93

Clearing jams..............................................................................................................94
Avoiding jams..................................................................................................................94
Accessing jam areas.........................................................................................................94
Understanding jam lights and access locations.........................................................95
Clearing jams behind the photoconductor kit and toner cartridge..........................99
Clearing jams from the standard exit bin.................................................................101
Clearing jams from Tray 1..........................................................................................101
Clearing jams from Tray 2..........................................................................................103
Clearing jams in the manual feeder..........................................................................104
Clearing jams behind the rear door............................................................................105

Troubleshooting..........................................................................................................107
Understanding printer messages................................................................................107
Close door .....................................................................................................................107
Load <input src> with <custom type name>..............................................................107
Load <input src> with <custom string>.....................................................................107
Load <input src> with <size>...................................................................................107
Load <input src> with <type> <size>........................................................................107
Load manual feeder with <type> <size>.................................................................107
Load manual feeder with <custom type name>......................................................108
Load manual feeder with <custom string>..............................................................108
Remove paper from standard output bin...............................................................108
31 Defective cartridge ...............................................................................................108
32.yy Replace unsupported cartridge.......................................................................108
58 Too many flash options installed ......................................................................108
58 Too many trays attached .....................................................................................109
59 Incompatible tray <x> ..........................................................................................109
88 Replace toner.........................................................................................................109

Solving basic printer problems.............................................................................109
Solving printing problems.......................................................................................110
Jobs do not print..........................................................................................................110
Multiple-language PDFs do not print.................................................................111
Job takes longer than expected to print...............................................................111
Job prints from the wrong tray or on the wrong paper.........................................111
Incorrect characters print......................................................................................112
Tray linking does not work.....................................................................................112
CAUTION—POTENTIAL INJURY: See the enclosed Safety Sheet before making any cable or electrical connection.

Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

Use care when you replace a lithium battery.

CAUTION—POTENTIAL INJURY: There is a danger of explosion if a lithium battery is incorrectly replaced. Replace it only with the same or an equivalent type of lithium battery. Do not recharge, disassemble, or incinerate a lithium battery. Discard used batteries according to the manufacturer’s instructions and local regulations.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more trained personnel to move it safely.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or printer damage:

- Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.
- Disconnect all cords and cables from the printer before moving it.
- Lift the printer off the optional drawer, and set it aside instead of trying to lift the drawer and printer at the same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

Use only the power cord provided with this product or the manufacturer’s authorized replacement.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well, and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific manufacturer’s components. The safety features of some parts may not always be obvious. The manufacturer is not responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug the power cord from the wall outlet and disconnect all cables from the printer before proceeding.
**CAUTION—SHOCK HAZARD:** Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning storm.

**CAUTION—TIPPING HAZARD:** Floor-mounted configurations require additional furniture for stability. You must use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and faxes, you may need additional furniture. For more information, see [www.lexmark.com/multifunctionprinters](http://www.lexmark.com/multifunctionprinters).

See the product *User's Guide* for additional safety information.

**SAVE THESE INSTRUCTIONS.**
Thank you for choosing this printer!

We've worked hard to make sure it will meet your needs.

To start using your new printer right away, use the setup materials that came with the printer, and then skim the User’s Guide to learn how to perform basic tasks. To get the most out of your printer, read the User’s Guide carefully, and make sure you check the latest updates on our Web site.

We’re committed to delivering performance and value with our printers, and we want to make sure you’re satisfied. If you do encounter any problems along the way, one of our knowledgeable support representatives will be delighted to help you get back on track fast. And if you find something we could do better, please let us know. After all, you are the reason we do what we do, and your suggestions help us do it better.

### Finding information about the printer

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial setup instructions:</td>
<td>Setup documentation—The setup documentation came with the printer and is also available on the Lexmark Web site at <a href="http://support.lexmark.com">http://support.lexmark.com</a>.</td>
</tr>
<tr>
<td>• Connecting the printer</td>
<td></td>
</tr>
<tr>
<td>• Installing the printer software</td>
<td></td>
</tr>
<tr>
<td>• Selecting and storing paper and specialty media</td>
<td></td>
</tr>
<tr>
<td>• Loading paper</td>
<td></td>
</tr>
<tr>
<td>• Performing printing depending on your printer model</td>
<td></td>
</tr>
<tr>
<td>• Configuring printer settings</td>
<td></td>
</tr>
<tr>
<td>• Viewing and printing documents and photos</td>
<td></td>
</tr>
<tr>
<td>• Setting up and using printer software</td>
<td></td>
</tr>
<tr>
<td>• Setting up and configuring the printer on a network, depending on your printer model</td>
<td></td>
</tr>
<tr>
<td>• Caring for and maintaining the printer</td>
<td></td>
</tr>
<tr>
<td>• Troubleshooting and solving problems</td>
<td></td>
</tr>
<tr>
<td>Help using the printer software</td>
<td>Windows or Mac Help—Open a printer software program or application, and then click Help. Click ? to view context-sensitive information.</td>
</tr>
</tbody>
</table>

**Notes:**

- The Help installs automatically with the printer software.
- The printer software is located in the printer Program folder or on the desktop, depending on your operating system.
<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>The latest supplemental information, updates, and technical support:</td>
<td>Lexmark Support Web site—<a href="http://support.lexmark.com">http://support.lexmark.com</a></td>
</tr>
<tr>
<td>• Documentation</td>
<td>Note: Select your region, and then select your product to view the appropriate support site.</td>
</tr>
<tr>
<td>• Driver downloads</td>
<td>Support telephone numbers and hours of operation for your region or country can be found on the Support Web site or on the printed warranty that came with your printer.</td>
</tr>
<tr>
<td>• Live chat support</td>
<td>Record the following information (located on the store receipt and the back of the printer), and have it ready when you contact support so that they may serve you faster:</td>
</tr>
<tr>
<td>• E-mail support</td>
<td>• Machine Type number</td>
</tr>
<tr>
<td>• Telephone support</td>
<td>• Serial number</td>
</tr>
<tr>
<td></td>
<td>• Date purchased</td>
</tr>
<tr>
<td></td>
<td>• Store where purchased</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Warranty information</th>
<th>Warranty information varies by country or region:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• In the US—See the Statement of Limited Warranty included with this printer, or at <a href="http://support.lexmark.com">http://support.lexmark.com</a>.</td>
</tr>
<tr>
<td></td>
<td>• Rest of the world—See the printed warranty that came with your printer.</td>
</tr>
</tbody>
</table>

**Selecting a location for the printer**

When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any options, leave enough room for them also. It is important to:

- Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard.
- Provide a flat, sturdy, and stable surface.
- Keep the printer:
  - Away from the direct airflow of air conditioners, heaters, or ventilators
  - Free from direct sunlight, humidity extremes, or temperature fluctuations
  - Clean, dry, and free of dust
- Allow the following recommended amount of space around the printer for proper ventilation:
<table>
<thead>
<tr>
<th></th>
<th>Rear</th>
<th>300 mm (12 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Right side</td>
<td>200 mm (8 in.)</td>
</tr>
<tr>
<td>3</td>
<td>Front</td>
<td>300 mm (12 in.)</td>
</tr>
<tr>
<td>4</td>
<td>Left side</td>
<td>12.7 mm (0.5 in.)</td>
</tr>
<tr>
<td>5</td>
<td>Top</td>
<td>300 mm (12 in.)</td>
</tr>
</tbody>
</table>

**Printer configurations**

**Basic model**

The following illustration shows the printer front with its basic features or parts:
The following illustration shows the printer back with its basic features or parts:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Front door release button</td>
</tr>
<tr>
<td>2</td>
<td>Paper stop</td>
</tr>
<tr>
<td>3</td>
<td>Standard exit bin</td>
</tr>
<tr>
<td>4</td>
<td>Printer control panel</td>
</tr>
<tr>
<td>5</td>
<td>System board door</td>
</tr>
<tr>
<td>6</td>
<td>Standard 250-sheet tray (Tray 1)</td>
</tr>
<tr>
<td>7</td>
<td>Manual feeder door</td>
</tr>
<tr>
<td>8</td>
<td>Front door</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>Rear door</td>
</tr>
<tr>
<td>2</td>
<td>Ethernet port</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Ethernet port is a feature on network models only.</td>
</tr>
<tr>
<td>3</td>
<td>USB port</td>
</tr>
<tr>
<td>4</td>
<td>Parallel port</td>
</tr>
<tr>
<td>5</td>
<td>Printer power cord socket</td>
</tr>
<tr>
<td>6</td>
<td>Power switch</td>
</tr>
<tr>
<td>7</td>
<td>Security slot</td>
</tr>
</tbody>
</table>

**Configured models**

The following illustration shows the printer configured with an optional 250- or 550-sheet drawer:
Understanding the printer control panel

The printer control panel features six lights and two buttons.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Error light</td>
</tr>
<tr>
<td>2</td>
<td>Jam light</td>
</tr>
<tr>
<td>3</td>
<td>Load paper light</td>
</tr>
<tr>
<td>4</td>
<td>Toner light</td>
</tr>
<tr>
<td>5</td>
<td>Ready light</td>
</tr>
<tr>
<td>6</td>
<td>Continue button</td>
</tr>
<tr>
<td>7</td>
<td>Stop button</td>
</tr>
</tbody>
</table>

Learning about the printer
Additional printer setup

Installing internal options

⚠️ CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well, and unplug any cables going into the printer.

You can customize your printer connectivity and memory capacity by adding optional cards. The instructions in this section explain how to install the available cards; you can also use them to locate a card for removal.

Available internal options

Memory cards
- Printer memory
- Flash memory
- Fonts

Accessing the system board to install internal options

⚠️ CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well, and unplug any cables going into the printer.

1. As you face the printer, the system board door is on the right side. Open the system board door.

2. Use the following illustration to locate the appropriate connector.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch a metal surface on the printer before touching any system board electronic components or connectors.
Installing a memory card

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch a metal surface on the printer before touching any system board electronic components or connectors.
An optional memory card can be purchased separately and attached to the system board. To install the memory card:

1. Turn the printer off.
2. Access the system board.
3. Unpack the memory card.
   
   **Note:** Avoid touching the connection points along the edge of the card.
4. Align the memory card with its connector on the system board.
5. Push open the latches on both ends of the memory connector.
   
   **Warning—Potential Damage:** Memory cards are easily damaged by static electricity. Touch a grounded metal surface before you touch a memory card.
   
   **Note:** Memory cards designed for other printers may not work with your printer.
6. Push the memory card into the connector until the latches *click* into place.
It may require some force to fully seat the card.

7 Ensure that each latch fits over the notch on each end of the card.

8 Close the system board door.

9 Turn the printer back on.

10 Open the printers folder:
   a Click 🌐, or click Start and then click Run.
   b In the Start Search or Run box, type control printers.
   c Press Enter, or click OK.

   The printers folder opens.

11 Right-click your printer icon.

12 Click Properties.

13 Click Install Options.

   Note: Memory cards designed for other printers may not work with your printer.

14 Click Ask Printer.

15 Click OK.

16 Click OK, and then close the printers folder.

Installing hardware options

Installing a 250- or 550-sheet drawer

⚠️ CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more trained personnel to move it safely.
An optional drawer attaches under the printer. A drawer consists of two parts: a tray and a support unit. The printer supports one optional drawer; you can install a 250- or 550-sheet drawer.

⚠️ CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well, and unplug any cables going into the printer.

1. Unpack the drawer, and remove any packing material.
2. Remove the tray from the support unit.
3. Remove any packing material and tape from inside the tray.
4. Insert the tray into the support unit.
5. Place the drawer in the location chosen for the printer.
6 Align the outer edges of the printer with the outer edges of the drawer, and then slowly lower the printer into place.

7 Turn the printer back on.

8 Open the printers folder:
   a Click ☯, or click Start and then click Run.
   b In the Start Search or Run box, type control printers.
   c Press Enter, or click OK.
      The printers folder opens.

9 Right-click the icon of your printer.

10 Click Properties.

11 Click Install Options.

12 Click Ask Printer.

13 Click OK.

14 Click OK, and then close the printers folder.
Printing the printer settings configuration sheet

The printer settings configuration sheet shows the current configuration settings. It also provides instructions on how to navigate through the configuration menus to select and save new settings. To print the printer settings configuration sheet:

1. Turn the printer off.
2. Open the front door.
3. Press and hold \( \text{[Down]}/\text{[Right]} \) as you turn the printer on.
   All the lights cycle.
4. Release \( \text{[Down]}/\text{[Right]} \).
5. Close the front door.
   The light sequence representing the home menu appears.

   Home Menu
   \( \text{- On} \)
   \( \text{[Down]}/\text{[Right]} - \text{On} \)
   \( \text{- On} \)
   \( \text{[Down]}/\text{[Right]} - \text{On} \)
6. Press \( \text{[Down]}/\text{[Right]} \) until all the lights cycle.
   The printer settings configuration sheet prints.

Note: The sheet prints only when the home menu light sequence is on.

Attaching cables

1. Connect the printer to a computer or a network.
   - For a local connection, use a USB or parallel cable.
   - For a network connection, use an Ethernet cable.
2. Connect the power cord to the printer first and then to a wall outlet.
1 Ethernet port
   Note: The Ethernet port is a feature on network models only.
2 USB port
3 Parallel port
4 Printer power cord socket

Setting up the printer software

Installing printer software

A printer driver is software that lets the computer communicate with the printer. The printer software is typically installed during the initial printer setup.

For Windows users

1 Close all open software programs.
2 Insert the Software and Documentation CD.
3 From the main installation dialog, click Install Printer and Software.
4 Follow the instructions on the computer screen.
For Macintosh users

1. Close all open software applications.
2. Insert the Software and Documentation CD.
3. From the Finder desktop, double-click the printer CD icon that automatically appears.
4. Double-click the Install Printer and Software icon.
5. Follow the instructions on the computer screen.

Using the World Wide Web

2. From the Drivers & Downloads menu, click Driver Finder.
3. Select your printer, and then select your operating system.
4. Download the driver and install the printer software.

Updating available options in the printer driver

Once the printer software and any options are installed, it may be necessary to manually add the options in the printer driver to make them available for print jobs.

For Windows users

1. Open the Printers folder:
   a. Click ☰, or click Start and then click Run.
   b. In the Start Search or Run box, type control printers.
   c. Press Enter, or click OK.

   The printer folder opens.
2. Select the printer.
3. Right-click the printer, and then select Properties.
4. Click the Install Options tab.
5. Under Available Options, add any installed hardware options.
6. Click Apply.

For Macintosh users

In Mac OS X version 10.5 or later

1. From the Apple menu, choose System Preferences.
2. Click Print & Fax.
3. Select the printer, and then click Options & Supplies.
4. Click Driver, and then add any installed hardware options.
5. Click OK.
In Mac OS X version 10.4 and earlier

1 From the Finder desktop, choose Go > Applications.
2 Double-click Utilities, and then double-click Print Center or Printer Setup Utility.
3 Select the printer, and then from the Printers menu, choose Show Info.
4 From the pop-up menu, choose Installable Options.
5 Add any installed hardware options, and then click Apply Changes.
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide collection and recycling programs. For more information, see:

- The Notices chapter
- The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
- The Lexmark recycling program at www.lexmark.com/recycle

By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter outlines the settings and tasks that may yield a greater environmental benefit.

**Saving paper and toner**

**Using recycled paper and other office papers**

As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for use in laser (electrophotographic) printers. In 1998, Lexmark presented to the US government a study demonstrating that recycled paper produced by major mills in the US fed as well as non-recycled paper. However, no blanket statement can be made that all recycled paper will feed well.

Lexmark consistently tests its printers with recycled paper (20–100% post-consumer waste) and a variety of test paper from around the world, using chamber tests for different temperature and humidity conditions. Lexmark has found no reason to discourage the use of today's recycled office papers, but generally the following property guidelines apply to recycled paper.

- Low moisture content (4–5%)
- Suitable smoothness (100–200 Sheffield units, or 140–350 Bendtsen units, European)

  **Note:** Some much smoother papers (such as premium 24 lb laser papers, 50–90 Sheffield units) and much rougher papers (such as premium cotton papers, 200–300 Sheffield units) have been engineered to work very well in laser printers, despite surface texture. Before using these types of paper, consult your paper supplier.

- Suitable sheet-to-sheet coefficient of friction (0.4–0.6)
- Sufficient bending resistance in the direction of feed

Recycled paper, paper of lower weight (<60 g/m² [16 lb bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and paper that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is required for reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing, consult your paper supplier. Remember that these are general guidelines only and that paper meeting these guidelines may still cause paper feeding problems in any laser printer (for example, if the paper curls excessively under normal printing conditions).

**Conserving supplies**

There are a number of ways you can reduce the amount of paper and toner you use when printing. You can:
Use both sides of the paper
If your printer model supports duplex printing, you can control whether print appears on one or two sides of the paper by selecting 2-sided printing from the Print dialog or the Lexmark Toolbar.

Place multiple pages on one sheet of paper
You can print up to 16 consecutive pages of a multiple-page document onto one side of a single sheet of paper by selecting a setting from the Multipage printing (N-Up) section of the Print dialog.

Check your first draft for accuracy
Before printing or making multiple copies of a document:
• Use the preview feature, which you can select from the Print dialog or the Lexmark Toolbar, to see how the document will look before you print it.
• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams
Carefully select and load paper to avoid paper jams. For more information, see “Avoiding jams” on page 94.

Saving energy

Adjusting Power Saver
Increase or decrease the number of minutes before the printer enters Power Saver mode.
If your printer is connected to a computer by a USB or parallel cable, use the Local Printer Settings Utility for Windows or Printer Settings for Macintosh.
1 Click Setup.
2 Ensure that the Power Saver check box is selected.
3 Clicking the small arrow buttons, increase or decrease the number of minutes before the printer enters Power Saver mode. Available settings range from 1–240 minutes.
4 From the menu bar, click Actions ➔ Apply Settings.

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information, see:
• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle
Recycling Lexmark products

To return Lexmark products to Lexmark for recycling:

2. Find the product type you want to recycle, and then select your country from the list.
3. Follow the instructions on the computer screen.

Recycling Lexmark packaging

Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.

Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.

The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your area.

When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the box.

Returning Lexmark cartridges for reuse or recycling

The Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return the cartridges are also recycled.

To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and use the pre-paid shipping label. You can also:

2. From the Toner Cartridges section, select your country from the list.
3. Follow the instructions on the computer screen.

Minimizing your printer's environmental impact
Interpreting the printer control panel lights

Understanding the printer control panel light sequences

Understanding the primary light sequences

<table>
<thead>
<tr>
<th>Printer control panel</th>
<th>Lights and buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Error</td>
<td>1 Error</td>
</tr>
<tr>
<td>2 Jam</td>
<td>2 Jam</td>
</tr>
<tr>
<td>3 Load paper</td>
<td>3 Load paper</td>
</tr>
<tr>
<td>4 Toner</td>
<td>4 Toner</td>
</tr>
<tr>
<td>5 Ready</td>
<td>5 Ready</td>
</tr>
<tr>
<td>6 Continue</td>
<td>6 Continue</td>
</tr>
<tr>
<td>7 Stop</td>
<td>7 Stop</td>
</tr>
</tbody>
</table>

The printer control panel features six lights and two buttons. The lights can be on, off, blinking, or blinking slowly.

<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Error</td>
<td>- Blinking</td>
</tr>
<tr>
<td>- Blinking</td>
<td></td>
</tr>
<tr>
<td>- Blinking</td>
<td></td>
</tr>
<tr>
<td>- Blinking</td>
<td>- Blinking</td>
</tr>
<tr>
<td>- Blinking</td>
<td>- Blinking</td>
</tr>
<tr>
<td>- Blinking</td>
<td>- Blinking</td>
</tr>
<tr>
<td>- Blinking</td>
<td>- Blinking</td>
</tr>
<tr>
<td>- Blinking</td>
<td>- Blinking</td>
</tr>
</tbody>
</table>

Turn the printer off, and then on. If the lights are still blinking, then visit the Lexmark support Web site at http://support.lexmark.com.
<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace PC Kit</td>
<td>Replace the photoconductor kit.</td>
</tr>
<tr>
<td>⚠️ - Blinking</td>
<td></td>
</tr>
<tr>
<td>⚠️/∥</td>
<td></td>
</tr>
<tr>
<td>⚫ - On</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready</td>
<td>Send a print job.</td>
</tr>
<tr>
<td>⚫ - On (green)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Saver</td>
<td>Send a print job.</td>
</tr>
<tr>
<td>⚫ - On (yellow)</td>
<td></td>
</tr>
<tr>
<td>Light sequence</td>
<td>What to do</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Hex Trace Ready</strong></td>
<td>Use Hex Trace to troubleshoot printing problems. Turn the printer off, and then on to return to the <strong>Ready</strong> state.</td>
</tr>
<tr>
<td>✨ - Slowly Blinking</td>
<td></td>
</tr>
<tr>
<td><strong>Busy</strong></td>
<td>Wait or press ✗.</td>
</tr>
<tr>
<td>✨ - Blinking</td>
<td></td>
</tr>
<tr>
<td><strong>Flushing Buffer</strong></td>
<td>Wait until the printer returns to the <strong>Ready</strong> state.</td>
</tr>
<tr>
<td>🚨 - Blinking</td>
<td></td>
</tr>
</tbody>
</table>

Interpreting the printer control panel lights
<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Waiting</strong>&lt;br&gt;🌙 - On&lt;br&gt;▷ - On</td>
<td>Wait for the light sequence to clear.</td>
</tr>
<tr>
<td><strong>Canceling job</strong>&lt;br&gt;⚠️ - On&lt;br&gt;<code>/</code> - On&lt;br&gt; afterEach - On&lt;br&gt;.setVertical - On&lt;br&gt;🌙 - On&lt;br&gt;▷ - On</td>
<td>Wait for the light sequence to clear.</td>
</tr>
<tr>
<td><strong>Invalid Engine Code or Invalid Network Code</strong>&lt;br&gt;⚠️ - On&lt;br&gt;🌙 - On</td>
<td>Press ▷ twice to get the secondary message. Use valid code when programming the printer.</td>
</tr>
<tr>
<td>Light sequence</td>
<td>What to do</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Not ready</td>
<td>Press and release either ⏩ or ⏣ to return to the <strong>Ready</strong> state.</td>
</tr>
<tr>
<td>Cartridge error</td>
<td>Replace the toner cartridge with one suitable for your region.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This LED pattern also indicates other problems with the cartridge. Press ⏩ twice quickly to see the secondary message. For more information, see “Understanding the secondary error light sequences” on page 36.</td>
</tr>
<tr>
<td>Front door is open</td>
<td>Close the front door.</td>
</tr>
<tr>
<td>Light sequence</td>
<td>What to do</td>
</tr>
<tr>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><strong>No paper in Tray 1 or Tray 2</strong>&lt;br&gt;- On&lt;br&gt;- On</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td><strong>No paper in the manual feeder</strong>&lt;br&gt;- On</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td><strong>Remove paper from the standard exit bin</strong>&lt;br&gt;- Blinking</td>
</tr>
</tbody>
</table>
### Cartridge is low

<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Press and release ![to clear the light sequence and continue processing the print job.</td>
</tr>
<tr>
<td>![</td>
<td>With the printer turned off, remove the toner cartridge and shake it to extend its life.</td>
</tr>
<tr>
<td>![</td>
<td>Replace the toner cartridge, and then turn the printer on.</td>
</tr>
</tbody>
</table>

### PC Kit life warning

<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>![</td>
<td>Press and release ![to clear the light sequence and continue processing the print job.</td>
</tr>
<tr>
<td>![</td>
<td>Replace the photoconductor kit.</td>
</tr>
</tbody>
</table>

### The following light sequences show that there is a secondary error code or secondary jam code to read:

<table>
<thead>
<tr>
<th>Light sequence</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>![</td>
<td>Press twice quickly to see the secondary error code.</td>
</tr>
</tbody>
</table>

---

**Interpreting the printer control panel lights**
Understanding the secondary error light sequences

When the ▶ and ♂ lights are on simultaneously, press ▶ twice quickly to see the secondary error code.

Interpreting the printer control panel lights
<table>
<thead>
<tr>
<th>Light sequences</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="light_sequences.png" alt="Image" /></td>
<td>Press either ▶️ or ✗️ to clear the light sequence.</td>
</tr>
</tbody>
</table>

**Complex page, some data may not have printed**

- On
- On
- On

**Insufficient memory to collate job**

- On
- On
- On
- On

**Insufficient memory to support Resource Save feature**

- On
- Blinking
- On

- Install additional printer memory.
- Press either ▶️ or ✗️ to clear the light sequence. Job will be printed without Resource Save.

---

Interpreting the printer control panel lights

37
<table>
<thead>
<tr>
<th>Light sequences</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>! - On&lt;br/&gt;-&gt; - Blinking&lt;br/&gt;□ - Blinking&lt;br/&gt;▶ - On</td>
<td>Press ▶ to clear the code. The printer discards any print jobs previously sent.</td>
</tr>
</tbody>
</table>
| ! - On<br/>-&gt; - Blinking<br/>□ - On<br/>☀ - On | • Ensure that the paper you loaded is large enough.  
• Clear any paper jam.  
• Press ▶ to clear the code and continue the print job. |
| ! - On<br/>□ - On<br/>☀ - On<br/>▶ - On | Replace the toner cartridge with one that is suitable for your region. For more information, see “Replacing the toner cartridge” on page 86. |

Interpreting the printer control panel lights

38
<table>
<thead>
<tr>
<th>Light sequences</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace missing or defective cartridge</td>
<td>Replace the toner cartridge. For more information, see “Replacing the toner cartridge” on page 86.</td>
</tr>
</tbody>
</table>
| ! - On  
$\text{\$}/\text{\$}^\gamma$ - Blinking  
\(\text{\$}/\text{\$}\) - On | Remove the toner cartridge and replace it with a supported toner cartridge. For more information, see “Replacing the toner cartridge” on page 86. |

Interpreting the printer control panel lights

39
Loading paper and specialty media

This section explains how to load the 250- and 550-sheet trays, and the manual feeder. It also includes information about setting the Paper Size and Paper Type.

Setting the paper size and type

Ensure that the settings for the trays reflect the size and type of paper loaded in the trays. The factory default paper type setting is plain paper, so the paper type setting must be set manually for all trays that do not contain plain paper.

If the printer is on a network, access the Embedded Web Server by typing the IP address of the printer in the address bar of a Web browser. From the Settings tab, click Paper Menu.

If the printer is connected to a computer by a USB or parallel cable, use one of the following utilities to access the Paper menu, depending on your operating system:
- For Windows users, access the Paper menu through the Local Printer Settings Utility.
- For Macintosh users, access the Paper menu through the Printer Settings.

Note: The Paper Size and Type settings will be saved until you reset factory default settings. If you would like to override the Paper Size and Type settings for a special print job, do one of the following:
- For Windows users, click File → Print, and then click Properties, Preferences, Options, or Setup.
- For Macintosh users, choose File > Print, and then adjust the settings from the print dialog and pop-up menus.

Configuring Universal paper settings

The Universal Paper Size is a user-defined setting that lets you print on paper sizes that are not preset in the printer menus. Defining a specific height and width measurement for the Universal paper size, in the portrait orientation, allows the printer to support the size. Specify all of the following Universal size settings for your paper:
- Units of measure (inches or millimeters)
- Portrait Width
- Portrait Height

Note: The smallest supported Universal size is 76.2 x 127 mm (3 x 5 in.); the largest is 216 x 356 mm (8.5 x 14 in.).
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with your printer software. Under the Paper menu, select Universal in the Paper Size selection box for the tray that will contain the Universal paper.

Loading the standard 250-sheet tray

The printer has two trays to select from: the standard tray (Tray 1), also known as the 250-sheet tray, and either the optional 250-sheet tray or the optional 550-sheet tray (Tray 2). Only one optional drawer (which includes an optional tray) may be attached to the printer at a time.
Proper paper loading prevents jams and facilitates trouble-free printing.

1 Pull the tray completely out.

Do not remove trays while a job prints or when the Busy light sequence appears on the printer control panel. Doing so may cause a jam.

2 Squeeze the width guide tabs, and then slide them to the sides of the tray. The width guides move in unison.

3 Squeeze the length guide tabs together, and then slide the length guide to the correct position for the paper size being loaded.
If you are loading a longer size of paper like A4 or legal, squeeze the length guide tabs and slide the length guide backwards to the position for the length of paper you are loading. The tray extends backwards.

If you are loading A6-size paper:

a Squeeze the length guide tabs together as shown, and slide the length guide toward the center of the tray to the A6 size position.

b Raise the A6 length guide.

Note: The standard tray accommodates only 150 sheets of A6-size paper.

Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the edges on a level surface.
5 Load the paper stack toward the back of the tray as shown with the recommended print side facedown.

**Note:** Notice the maximum fill line. Do not try to overload the tray. Do not load A6-size paper to the maximum fill line; the tray holds only 150 sheets of A6-size paper.

```
1 Maximum fill line
```

**Note:** When loading letterhead, place the top edge of the sheet toward the front of the tray. Load the letterhead with the design placed facedown.
6 Squeeze the width guide tabs on the right guide, and slide the width guides to lightly touch the side of the stack.

7 Insert the tray.

8 If a different type of paper was loaded than the type previously loaded in the tray, change the Paper Type setting. For more information, see “Setting the paper size and type” on page 40.

Note: The difference between the standard 250-sheet tray and the optional 250- and 550-sheet trays is that the standard tray accommodates up to 150 sheets of A6-size paper, so the width guides slide farther to the center of the tray.
Loading the optional 250- or 550-sheet tray

Only one optional drawer, which includes either a 250- or 550-sheet tray, may be attached to the printer at a time. Regardless of the number of sheets in the optional tray, it is referred to as Tray 2.

1. Pull the tray completely out.

2. See “Loading the standard 250-sheet tray” on page 40 to complete the steps for loading a tray. An optional tray is loaded in the same way that the standard tray is loaded.

3. Insert the tray.
Using the manual feeder

The manual feeder is located inside the manual feeder door of the printer and can feed only one sheet of paper at a time. You can use the manual feeder to quickly print on paper types or sizes that are not currently loaded in the tray.

1. Open the manual feeder door.

2. When the light is lit, load the paper faceup into the center of the manual feeder.

Notes:

- Load letterhead faceup, with the top of the sheet entering first.
- Load envelopes with the flap side down and with the stamp area as shown.
3 Feed paper into the manual feeder only to the point where its leading edge can contact the paper guides.

4 Adjust the paper guides to the paper width.

Warning—Potential Damage: Do not force the paper into the feeder. Forcing the paper causes jams.

Using the standard exit bin and paper stop

The standard exit bin holds up to 150 sheets of 20 lb paper. It collects print jobs facedown. The standard exit bin includes a paper stop that keeps paper from sliding out the front of the bin as it stacks. The paper stop also aids in neater stacking of the paper.

To open the paper stop, pull it so it flips forward.

Notes:

- Do not leave the paper stop in the open position if you are printing on transparencies. Doing so may cause creases in the transparencies.
- When moving the printer to another location, make sure the paper stop is closed.
Linking and unlinking trays

Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from the next linked tray. When the Size and Type settings are the same for any trays, the trays are automatically linked. The Size and Type settings for all trays must be set from the Paper menu.

To initiate tray linking from a network printer, access the Embedded Web Server by typing the IP address of the printer in the address bar of a Web browser. From the Settings tab, click Paper Menu.

To initiate tray linking from a locally connected printer:
- For Windows users, access the Paper menu through the Local Printer Settings Utility.
- For Macintosh users, access the Paper menu through the Printer Settings.

Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray. To unlink a tray using the Paper menu, change the Paper Type and Paper Size settings of that tray so that they do not match the settings of any other tray.

To unlink trays from a network printer, access the Embedded Web Server by typing the IP address of the printer in the address bar of a Web browser. From the Settings tab, click Paper Menu.

To unlink trays from a locally connected printer, do one of the following:
- For Windows users, access the Paper menu through the Local Printer Settings Utility. Then, change the Paper Type and Paper Size settings of the tray so that they do not match the settings of any other tray.
- For Macintosh users, access the Paper menu through the Printer Settings. Then, change the Paper Type and Paper Size settings of the tray so that they do not match the settings of any other tray.

Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type of paper loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper may not be properly processed if an inaccurate Paper Type is selected.

Assigning a custom paper type name to a tray
Assign a Custom Type <x> name to a tray to link or unlink it. Associate the same Custom Type <x> name to each tray that you want to link. Only trays with the same custom names assigned will link.

1. Do one of the following:
   - If the printer is on a network, access the Embedded Web Server by typing the IP address of the printer in the address bar of a Web browser.
   - If the printer is connected to a computer by a USB or parallel cable, access the Paper menu through the Local Printer Settings Utility for Windows or Printer Settings for Macintosh.

2. Click Settings, and then click Paper Menu.

3. Click Custom Name, and then enter the name for the paper.

4. Click Submit.

5. Select a Custom Type.
6  Verify that the correct Paper Type is associated with the custom name.

   **Note:** Plain Paper is the factory default Paper Type associated with all Custom Type \(<x>\) names and user-defined custom names.

7  Click **Submit**.
Paper and specialty media guide

Paper guidelines

Paper capacities

The capacities of the trays and the manual feeder are based on 75 g/m² (20 lb) paper.

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tray 1</strong></td>
<td>Vinyl, pharmacy, or dual-sided labels are not supported. Use paper</td>
</tr>
<tr>
<td>250 sheets of paper</td>
<td>labels only. Single-sided paper labels designed for laser printers are</td>
</tr>
<tr>
<td>150 sheets of A6-size</td>
<td>supported for occasional use.</td>
</tr>
<tr>
<td>paper</td>
<td></td>
</tr>
<tr>
<td>50 paper labels</td>
<td></td>
</tr>
<tr>
<td>50 transparencies</td>
<td></td>
</tr>
<tr>
<td><strong>Tray 2</strong></td>
<td>Only one optional drawer may be installed on the printer at a time.</td>
</tr>
<tr>
<td>250 or 550 sheets of</td>
<td>The maximum amount of paper that can be loaded depends on whether</td>
</tr>
<tr>
<td>paper</td>
<td>you have an optional 250- or 550-sheet tray.</td>
</tr>
<tr>
<td>50 paper labels</td>
<td>Vinyl, pharmacy, or dual-sided labels are not supported. Use paper</td>
</tr>
<tr>
<td></td>
<td>labels only. Single-sided paper labels designed for laser printers are</td>
</tr>
<tr>
<td></td>
<td>supported for occasional use.</td>
</tr>
<tr>
<td><strong>Manual feeder</strong></td>
<td>Feed paper into the manual feeder only to the point where its leading</td>
</tr>
<tr>
<td>1 sheet of paper</td>
<td>edge can contact the paper guides. Do not force the paper into the</td>
</tr>
<tr>
<td>1 sheet of A6-size</td>
<td>feeder.</td>
</tr>
<tr>
<td>paper</td>
<td></td>
</tr>
<tr>
<td>1 transparency</td>
<td></td>
</tr>
<tr>
<td>1 sheet of card stock</td>
<td></td>
</tr>
<tr>
<td>1 envelope</td>
<td></td>
</tr>
</tbody>
</table>

Paper characteristics

The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating new paper stock.

Weight

The printer trays can automatically feed paper weights up to 90 g/m² (24 lb bond) grain long paper. The manual feeder can automatically feed paper weights up to 163 g/m² (43 lb bond) grain long paper. Paper lighter than 60 g/m² (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75 g/m² (20 lb bond) grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 in.), we recommend 90 g/m² (24 lb) or heavier paper.

**Note:** Duplex printing is supported only for 60–90 g/m² (16–24 lb bond) paper.
Curl
Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid, cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding problems.

Smoothness
Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too smooth, it can cause paper feeding or print quality issues. Always use paper between 100–300 Sheffield points; smoothness between 150–250 Sheffield points produces the best print quality.

Moisture content
The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly. Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that can degrade its performance.

Condition paper before printing by storing it in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend the time several days if the storage or transportation environment is very different from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction
Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of the paper, or grain short, running the width of the paper.

For 60–90 g/m² (16–24 lb bond) paper, grain long paper is recommended.

Fiber content
Most high-quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless copy paper (CCP), or no carbon required (NCR) paper
• Preprinted papers with chemicals that may contaminate the printer
• Preprinted papers that can be affected by the temperature in the printer fuser
• Preprinted papers that require a registration (the precise print location on the page) greater than ±2.3 mm (±0.9 in.), such as optical character recognition (OCR) forms
  In some cases, registration can be adjusted with a software application to successfully print on these forms.
• Coated papers (erasable bond), synthetic papers, thermal papers
• Rough-edged, rough or heavily textured surface papers, or curled papers
• Recycled papers that fail EN12281:2002 (European)
• Paper weighing less than 60 g/m² (16 lb)
• Multiple-part forms or documents
Selecting paper

Using appropriate paper prevents jams and helps ensure trouble-free printing.

To help avoid jams and poor print quality:

- *Always* use new, undamaged paper.
- Before loading paper, know the recommended print side of the paper. This information is usually indicated on the paper package.
- *Do not* use paper that has been cut or trimmed by hand.
- *Do not* mix paper sizes, types, or weights in the same source; mixing results in jams.
- *Do not* use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead

Use these guidelines when selecting preprinted forms and letterhead:

- Use grain long for 60 to 90 g/m² weight paper.
- Use only forms and letterhead printed using an offset lithographic or engraved printing process.
- Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must be able to withstand temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by the resin in toner. Inks that are oxidation-set or oil-based generally meet these requirements; latex inks might not. When in doubt, contact the paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting or releasing hazardous emissions.

Storing paper

Use these paper storage guidelines to help avoid jams and uneven print quality:

- For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most label manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative humidity between 40 and 60%.
- Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.
- Store individual packages on a flat surface.
- Do not store anything on top of individual paper packages.
**Supported paper sizes, types, and weights**

The following tables provide information on standard and optional paper sources and the types of paper they support.

**Note:** For an unlisted paper size, select the closest *larger* listed size.

For information on card stock and labels, see the *Card Stock & Label Guide*.

### Paper sizes supported by the printer

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Dimensions</th>
<th>Standard 250-sheet tray</th>
<th>Optional 250- or 550-sheet tray</th>
<th>Manual feeder</th>
<th>Duplex path</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>210 x 297 mm (8.3 x 11.7 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>A5</td>
<td>148 x 210 mm (5.8 x 8.3 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>A6¹</td>
<td>105 x 148 mm (4.1 x 5.8 in.)</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Executive</td>
<td>184 x 267 mm (7.3 x 10.5 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Folio</td>
<td>216 x 330 mm (8.5 x 13 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>JIS B5</td>
<td>182 x 257 mm (7.2 x 10.1 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Legal</td>
<td>216 x 356 mm (8.5 x 14 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Letter</td>
<td>216 x 279 mm (8.5 x 11 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Oficio (Mexico)²</td>
<td>216 x 340 mm (8.5 x 13.4 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Statement</td>
<td>140 x 216 mm (5.5 x 8.5 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Universal³</td>
<td>76.2 x 127 mm (3 x 5 in.) up to 216 x 356 mm (8.5 x 14 in.)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>B5 Envelope</td>
<td>176 x 250 mm (6.9 x 9.8 in.)</td>
<td>X</td>
<td>X</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>C5 Envelope</td>
<td>162 x 229 mm (6.4 x 9 in.)</td>
<td>X</td>
<td>X</td>
<td>✓</td>
<td>X</td>
</tr>
</tbody>
</table>

¹ A6 is supported only for grain long papers.

² This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.

³ If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring Universal paper settings” on page 40.
### Paper sizes and dimensions supported

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Dimensions</th>
<th>250-sheet tray</th>
<th>Optional 250- or 550-sheet tray</th>
<th>Manual feeder</th>
<th>Duplex path</th>
</tr>
</thead>
<tbody>
<tr>
<td>DL Envelope</td>
<td>110 x 220 mm (4.3 x 8.7 in.)</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>7 3/4 Envelope (Monarch)</td>
<td>98 x 191 mm (3.9 x 7.5 in.)</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>9 Envelope</td>
<td>98 x 225 mm (3.9 x 8.9 in.)</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>10 Envelope</td>
<td>105 x 241 mm (4.1 x 9.5 in.)</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>Other Envelope</td>
<td>229 x 356 mm (9 x 14 in.)</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
</tbody>
</table>

1 A6 is supported only for grain long papers.
2 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
3 If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring Universal paper settings” on page 40.

### Paper types and weights supported by the printer

The printer engine and the duplex path support 60–90 g/m² (16–24 lb) paper weights. The manual feeder supports 60–163 g/m² (16–43 lb) paper weights.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>250-sheet standard tray</th>
<th>250- or 550-sheet optional tray</th>
<th>Manual feeder</th>
<th>Duplex path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Plain</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>• Light</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Heavy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Rough/Cotton</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Recycled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Custom</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bond</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Letterhead</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Preprinted</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Colored Paper</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Card stock</td>
<td>X</td>
<td>X</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>Glossy paper</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Paper labels¹</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>X</td>
</tr>
<tr>
<td>Paper type</td>
<td>250-sheet standard tray</td>
<td>250- or 550-sheet optional tray</td>
<td>Manual feeder</td>
<td>Duplex path</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
<td>---------------------------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Transparencies</td>
<td>✓</td>
<td>X</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Envelopes (smooth)²</td>
<td>X</td>
<td>X</td>
<td>✓</td>
<td>X</td>
</tr>
</tbody>
</table>

¹ Single-sided paper labels designed for laser printers are supported for occasional use. It is recommended to print 20 or fewer pages of paper labels a month. Vinyl, pharmacy, and dual-sided labels are not supported.  
² Use envelopes that lie flat when individually placed on a table facedown.
Printing

This chapter covers printing, printer reports, and job cancellation. Selection and handling of paper and specialty media can affect how reliably documents print. For more information, see “Avoiding jams” on page 94 and “Storing paper” on page 52.

Printing a document

Printing a document

1 Load paper into a tray or feeder.

2 From the Paper menu, set the Paper Size/Type to match the loaded paper.

3 Send the print job:

For Windows users

a With a document open, click File → Print.

b Click Properties, Preferences, Options, or Setup, and then adjust the settings as needed.

Note: To print on a specific size or type of paper, adjust the paper size or type settings to match the loaded paper, or select the appropriate tray or feeder.

c Click OK, and then click OK.

For Macintosh users

a Customize the settings as needed in the Page Setup dialog:

1 With a document open, choose File > Page Setup.

2 Choose a paper size or create a custom size to match the loaded paper.

3 Click OK.

b Customize the settings as needed in the Print dialog:

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the Print dialog and pop-up menus, adjust the settings as needed.

Note: To print on a specific paper type, adjust the paper type setting to match the loaded paper, or select the appropriate tray or feeder.

3 Click Print.
Printing on both sides of the paper

Some models of the printer have automatic duplex / 2-sided printing and other models have manual duplex / 2-sided printing.

Printing on both sides of the paper

If you want to print two-sided pages for every print job, or for most print jobs, then select Duplex in the Finishing menu. To access the Finishing menu, do one of the following:

- If the printer is connected to a computer by USB or parallel cable, then open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.
- For occasional two-sided printing, you can request two-sided printing in the printer software. Do one of the following, depending on your operating system:

For Windows users

1. With a document open, click File → Print.
2. Click Properties, Preferences, Options, or Setup.
4. Select Long edge or Short edge.
5. Click OK.

For Macintosh users

   If necessary, click the disclosure triangle to see more options.
2. From the print options, Copies & Pages, or General pop-up menu, choose Layout.
3. From the Two-Sided pop-up menu, choose a duplex setting.
4. Click Print.

Printing on both sides of the paper manually

If your printer does not have automatic two-sided (duplex) printing, and you want to print a duplex document, then you must use the manual duplexing method. This method involves printing the odd-numbered pages, and then flipping and reloading the stack of paper to print the even-numbered pages on the other side of the sheets.

- To duplex all print jobs, select Duplex in the Finishing menu. To access the Finishing menu, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.
- To duplex a single print job, do one of the following:

For Windows users

1. With a document open, click File → Print.
2. Click Properties, Preferences, Options, or Setup.
4. Select Long edge or Short edge.
5. Click Paper.
6 Select the appropriate **Input options** for your print job.

7 Click **OK**.

8 Click **OK** on the Print window.
   The printer prints every other page of the document first. Once the first side of your job prints, the light comes on, and the button light blinks.

![Printer Status Lights]

- **□** - On
- **▷** - Blinking

9 Load the paper back into the printer with the already-printed side up and the top of the page toward the front of the tray.

**For Macintosh users**

1 With a document open, choose **File → Print**.

2 From the print options pop-up menu, choose **Paper Handling**.

3 From the “Pages to print” or Print menu, select to print the odd-numbered pages.

4 Click **Print**.

5 After printing the first set of pages, flip and reload the stack of printouts.

6 Repeat steps 1 and 2.

7 From the “Pages to print” or Print menu, select to print the even-numbered pages.

8 Click **Print**.
Printing specialty documents

Tips on using letterhead

Page orientation is important when printing on letterhead. Use the following table to determine which direction to load the letterhead:

<table>
<thead>
<tr>
<th>Source or process</th>
<th>Print side and paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Standard 250-sheet tray</td>
<td>Printed letterhead design is placed facedown. The top edge of the sheet with the logo is placed at the front of the tray.</td>
</tr>
<tr>
<td>• Optional 250-sheet tray</td>
<td></td>
</tr>
<tr>
<td>• Optional 550-sheet tray</td>
<td></td>
</tr>
<tr>
<td>Duplex (two-sided) printing from trays</td>
<td>Printed letterhead design is placed faceup. The top edge of the sheet with the logo is placed at the rear of the tray.</td>
</tr>
<tr>
<td>Manual feeder (simplex printing)</td>
<td>Preprinted letterhead design is placed faceup. The top edge of the sheet with the logo should enter the manual feeder first.</td>
</tr>
</tbody>
</table>

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for laser printers.
Manual feeder (duplex printing)
Preprinted letterhead design is placed facedown. The top edge of the sheet with the logo should enter the manual feeder last.

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for laser printers.

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.
When printing on transparencies:
• Feed transparencies from the standard 250-sheet tray or the manual feeder.
• Use transparencies designed specifically for laser printers. Check with the manufacturer or vendor to ensure that the transparencies are able to withstand temperatures up to 175° C (350° F) without melting, discoloring, offsetting, or releasing hazardous emissions.
  
  Note: Transparencies can be printed at a temperature up to 180° C (356° F) if Transparency Weight is set to Heavy and Transparency Texture is set to Rough. Select these settings in the Paper menu using a local utility.
• To prevent print quality problems, avoid getting fingerprints on the transparencies.
• Before loading transparencies, fan the stack to prevent sheets from sticking together.
• We recommend Lexmark part number 70X7240 for letter-size transparencies and Lexmark part number 12A5010 for A4-size transparencies.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.
When printing on envelopes:
• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure the envelopes can withstand temperatures up to 210°C (410°F) without sealing, wrinkling, curling excessively, or releasing hazardous emissions.
• For the best performance, use envelopes made from 90 g/m² (24 lb bond) paper. Use up to 105 g/m² (28 lb bond) weight for envelopes as long as the cotton content is 25% or less. All-cotton envelopes must not exceed 90 g/m² (24 lb bond) weight.
• Use only new envelopes.
• To optimize performance and minimize jams, do not use envelopes that:
  – Have excessive curl or twist
  – Are stuck together or damaged in any way
  – Have windows, holes, perforations, cutouts, or embossing
– Have metal clasps, string ties, or folding bars
– Have an interlocking design
– Have postage stamps attached
– Have any exposed adhesive when the flap is in the sealed or closed position
– Have bent corners
– Have rough, cockle, or laid finishes
• Adjust the width guides to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal envelopes.

Tips on using labels

Print samples on the labels being considered for use before buying large quantities.

Note: Use only paper label sheets. Vinyl, pharmacy, and dual-sided labels are not supported.

For detailed information on label printing, characteristics, and design, see the Card Stock & Label Guide available on the Lexmark Web site at http://support.lexmark.com.

When printing on labels:
• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:
  – The labels can withstand temperatures up to 210°C (410°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.

  Note: Labels can be printed at a higher fusing temperature up to 220°C (428°F) if Label Weight is set to Heavy. Select this setting using the Embedded Web Server, or from the printer control panel Paper menu.
  – Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25-psi (172-kPa) pressure without delaminating, oozing around the edges, or releasing hazardous fumes.
• Do not use labels with slick backing material.
• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge warranties.
• Do not use labels with exposed adhesive.
• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die-cuts of the label.
• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm (0.04 in.) away from edges is recommended. Adhesive material contaminates the printer and could void the warranty.
• If zone coating of the adhesive is not possible, remove a 2-mm (0.06-in.) strip on the leading and driver edge, and use a non-oozing adhesive.
• Portrait orientation works best, especially when printing bar codes.

Tips on using card stock

Card stock is heavy, single-ply specialty media. Many of its variable characteristics, such as moisture content, thickness, and texture, can significantly impact print quality. Print samples on the card stock being considered for use before buying large quantities.

When printing on card stock:
• Make sure the Paper Type is Card Stock.
• Select the appropriate Paper Texture setting.
• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or other paper handling problems.
• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 210°C (410°F) without releasing hazardous emissions.
• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting introduces semi-liquid and volatile components into the printer.
• Use grain short card stock when possible.

Printing a booklet (Windows)
The booklet feature automatically enables 2-sided printing with short-edge control, so any 2-sided printing options must be set before selecting the booklet function. After Booklet is selected, the 2-sided printing options remain at the last setting used.

Some programs include their own booklet features. We recommend that when producing a booklet, you use either the booklet layout feature provided here or the booklet feature provided by the program the document was created in. Do not use both features at the same time.

1. With a document open, click File ➤ Print.
2. Click Properties, Preferences, Options, or Setup.
3. Click the Page Layout tab.
5. Click Booklet.
6. Click OK.

Notes:
• Booklet options are unavailable if the duplex unit is installed on the printer but not added to the Installed Options list.
• The PostScript Passthrough printer driver feature may need to be turned off in order for the booklet layout to work with some programs.

Printing information pages

Printing the menu settings and network setup pages
Print the menu settings page to review the current menu settings and to verify that the printer options are installed correctly. The network setup page prints at the same time, showing the network settings of the printer and levels of supplies.

1. Make sure the light is on.
2. Press ➤ .

The menu settings and network setup pages print.
On the menu settings page:

- Under the Paper Menu, check what papers are listed under Custom Types.
- Under Device Information, verify the amount of memory installed is correct.
- Under Cartridge Information, check the amount of toner.
- Under PC Unit, see the status of the photoconductor kit.

**Printing the print quality test pages**

Print the print quality test pages to isolate print quality problems.

1. Turn the printer off, and then open the front door.
2. Press and hold \( \text{ } \) while turning the printer on.
3. Release \( \text{ } \).
4. Close the front door. The home menu light sequence appears.

![Home menu light sequence](image)

- On
- On
- On
- On
- On
- \( \text{ } \) - On
- \( \text{ } \) - On
- \( \text{ } \) - On

5. Press and release \( \text{ } \) until you see the light sequence for print quality test pages, as indicated on the printer settings configuration page.
6. Press and hold \( \text{ } \) until all the lights cycle.

After a few minutes, the print quality test pages print. The pages include:

- An information page that contains information about the printer, the toner cartridge, the margin settings, and the minimum stroke width, and a graphic for evaluating the print quality
- Two pages to evaluate how well the printer is capable of printing various types of graphics

7. Examine the pages to determine the quality of printing. If there are problems, see “Solving print quality problems” on page 115.

To return to the home menu, press and hold \( \text{ } \) until all the lights cycle. To exit the menus, turn the printer off.
Canceling a print job

Canceling a print job from the printer control panel

1 Press \(\times\) to cancel the current print job.
2 Wait for the light to appear before resending the print job.

Canceling a print job from the computer

For Windows users

1 Open the printers folder:
   a Click \(\circ\), or click Start and then click Run.
   b In the Start Search or Run box, type control printers.
   c Press Enter, or click OK.
      The printers folder opens.
2 Double-click the printer icon.
3 Select the job to cancel.
4 From the keyboard, press Delete.

From the Windows taskbar:
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon.
   A list of print jobs appears in the printer window.
2 Select a job to cancel.
3 From the keyboard, press Delete.

For Macintosh users

In Mac OS X version 10.5 or later:

1 From the Apple menu, choose System Preferences.
2 Click Print & Fax, and then double-click the printer icon.
3 From the printer window, select the job to cancel.
4 From the icon bar at the top of the window, click the Delete icon.

In Mac OS X version 10.4 and earlier:

1 From the Go menu, choose Applications.
2 Double-click Utilities, and then double-click Printer Setup Utility or Print Center.
3 Double-click the printer icon.
4 From the printer window, select the job to cancel.
5 From the icon bar at the top of the window, click the Delete icon.

**Setting Jam Recovery**

To ensure that a page will reprint after a paper jam, set Jam Recovery to Auto or On.

If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. Under the Setup menu, ensure that Jam Recovery is set to Auto or On.
Understanding printer menus

You may print a menus list by printing the menu settings and network setup pages. Access the menus from a networked printer by using the Embedded Web Server. From a printer connected by USB or parallel cable, access the menus by using the Local Printer Settings Utility for Windows or Printer Settings for Macintosh.

Installing the Local Printer Settings Utility

The Local Printer Settings Utility lets you change and save settings for a printer that is connected to a computer locally through a USB or parallel cable. After installing this utility, you can change settings of such controls as Toner Darkness, Power Saver, Paper Size, and Paper Type. Once selected, these settings apply to all print jobs, but you can use the printer software to change these settings for individual print jobs.

You can also save custom settings in a command file to distribute these settings to designated printers by using the Save As Command File option.

1 Insert the Software and Documentation CD.

2 Click Install Printer and Software.

3 Click Agree to accept the license agreement.

4 Select Custom installation, and then click Next.

5 Choose Select Components to install the utility on the computer instead of creating a script, and then click Next.

6 Select Local to install the utility on the computer you are currently using, and then click Next.

7 Under Tools, select Local Printer Settings Utility.

8 Click Finish.

Note: This utility may not be included on this CD and/or may not be available for all printers.

Using the Local Printer Settings Utility

The Local Printer Settings Utility lets you change and save printer settings for a printer connected locally through a USB or parallel cable. Save settings from the toolbar by clicking Actions ➔ Apply Settings. You can also save your settings in a command file to distribute to designated printers by clicking Actions ➔ Save As Command File.

The Local Printer Settings Utility contains the following menus and values:

- Paper
- Finishing
- Quality
- Setup
- PCL Emulation
- PostScript
- Parallel
- USB
Using the Finishing menu

Use the Finishing menu to adjust settings for such features as Collate, Separator Sheets, and N-up (Multipage) printing. You can use the settings to collate pages, to insert separator sheets between print jobs, and to print up to 16 images on a single page. To access the Finishing menu, do one of the following:

- If the printer is connected to a network, open the Embedded Web Server by typing the printer IP address into the address field of your Web browser. From the Settings tab, click Print Settings, and then click Finishing Menu.
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.
Paper menu

Default Source menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Source</strong></td>
<td>Sets a default paper source for all print jobs</td>
</tr>
<tr>
<td>Tray &lt;x&gt;</td>
<td>Notes:</td>
</tr>
<tr>
<td>Manual Paper</td>
<td>• Tray 1 (standard tray) is the factory default setting.</td>
</tr>
<tr>
<td>Manual Env</td>
<td>• Only an installed paper source will appear as a menu setting.</td>
</tr>
<tr>
<td></td>
<td>• A paper source selected for a print job overrides the Default Source setting for the duration of the print job.</td>
</tr>
<tr>
<td></td>
<td>• If the same size and type of paper are in two trays and the Paper Size and Paper Type settings match, the trays are automatically linked. When one tray is empty, the job prints using paper from the linked tray.</td>
</tr>
</tbody>
</table>

Size/Type menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Source menu</strong></td>
<td>These menus let you specify the installed paper size and type in the selected tray or manual feeder.</td>
</tr>
<tr>
<td>Tray 1</td>
<td>Note: Only installed trays and feeders are listed in this menu.</td>
</tr>
<tr>
<td>Tray 2</td>
<td></td>
</tr>
<tr>
<td>Manual Paper</td>
<td></td>
</tr>
<tr>
<td>Manual Envelope</td>
<td></td>
</tr>
<tr>
<td><strong>Set Size menu for Tray 1 or Tray 2</strong></td>
<td>Lets you specify the paper size loaded in each tray</td>
</tr>
<tr>
<td>A4</td>
<td>Notes:</td>
</tr>
<tr>
<td>A5</td>
<td>• Letter is the US factory default setting. A4 is the international factory default setting.</td>
</tr>
<tr>
<td>A6</td>
<td>• If the same size and type of paper are in two trays and the Paper Size and Paper Type settings match, the trays are automatically linked. When one tray is empty, the job prints using paper from the linked tray.</td>
</tr>
<tr>
<td>JIS B5</td>
<td>• The A6 paper size is supported only in Tray 1.</td>
</tr>
<tr>
<td>Executive</td>
<td></td>
</tr>
<tr>
<td>Folio</td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td></td>
</tr>
<tr>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Oficio (Mexico)</td>
<td></td>
</tr>
<tr>
<td>Statement</td>
<td></td>
</tr>
<tr>
<td>Universal</td>
<td></td>
</tr>
<tr>
<td>Menu item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Set Size menu for Manual Paper</strong></td>
<td>Lets you specify the size of the paper being loaded in the manual feeder</td>
</tr>
<tr>
<td></td>
<td>Note: Letter is the US factory default setting. A4 is the international factory default setting.</td>
</tr>
<tr>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
</tr>
<tr>
<td>Executive</td>
<td></td>
</tr>
<tr>
<td>Folio</td>
<td></td>
</tr>
<tr>
<td>JIS B5</td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td></td>
</tr>
<tr>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Oficio (Mexico)</td>
<td></td>
</tr>
<tr>
<td>Statement</td>
<td></td>
</tr>
<tr>
<td>Universal</td>
<td></td>
</tr>
<tr>
<td><strong>Set Size menu for Manual Envelope</strong></td>
<td>Lets you specify the size of the envelope being manually loaded</td>
</tr>
<tr>
<td>7 3/4 Envelope</td>
<td>Note: 10 Envelope is the US factory default setting. DL Envelope is the international factory default setting.</td>
</tr>
<tr>
<td>9 Envelope</td>
<td></td>
</tr>
<tr>
<td>10 Envelope</td>
<td></td>
</tr>
<tr>
<td>C5 Envelope</td>
<td></td>
</tr>
<tr>
<td>B5 Envelope</td>
<td></td>
</tr>
<tr>
<td>DL Envelope</td>
<td></td>
</tr>
<tr>
<td>Other Envelope</td>
<td></td>
</tr>
<tr>
<td><strong>Set Type menu for Tray 1</strong></td>
<td>Lets you specify the type of paper loaded in Tray 1</td>
</tr>
<tr>
<td>Plain Paper</td>
<td>Notes:</td>
</tr>
<tr>
<td>Transparency</td>
<td>• Plain Paper is the factory default setting for Tray 1.</td>
</tr>
<tr>
<td>Recycled</td>
<td>• If available, a user-defined name will appear instead of Custom Type &lt;x&gt;.</td>
</tr>
<tr>
<td>Labels</td>
<td>• Use this menu item to configure automatic tray linking.</td>
</tr>
<tr>
<td>Bond</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
</tr>
<tr>
<td>Colored Paper</td>
<td></td>
</tr>
<tr>
<td>Light Paper</td>
<td></td>
</tr>
<tr>
<td>Heavy Paper</td>
<td></td>
</tr>
<tr>
<td>Rough/Cotton</td>
<td></td>
</tr>
<tr>
<td>Custom Type &lt;x&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Understanding printer menus
### Set Type menu for Tray 2

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Type menu for Tray 2</td>
<td>Lets you specify the type of paper loaded in Tray 2</td>
</tr>
<tr>
<td>Plain Paper</td>
<td></td>
</tr>
<tr>
<td>Card Stock</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td>Bond</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
</tr>
<tr>
<td>Colored Paper</td>
<td></td>
</tr>
<tr>
<td>Light Paper</td>
<td></td>
</tr>
<tr>
<td>Heavy Paper</td>
<td></td>
</tr>
<tr>
<td>Rough/Cotton</td>
<td></td>
</tr>
<tr>
<td>Custom Type &lt;x&gt;</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**
- Custom Type <x> is the factory default setting.
- If available, a user-defined name will appear instead of Custom Type <x>.
- Use this menu item to configure automatic tray linking.

### Set Type menu for Manual Paper

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Type menu for Manual Paper</td>
<td>Lets you specify the type of paper being manually loaded</td>
</tr>
<tr>
<td>Plain Paper</td>
<td></td>
</tr>
<tr>
<td>Card Stock</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td>Bond</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
</tr>
<tr>
<td>Colored Paper</td>
<td></td>
</tr>
<tr>
<td>Light Paper</td>
<td></td>
</tr>
<tr>
<td>Heavy Paper</td>
<td></td>
</tr>
<tr>
<td>Rough Paper</td>
<td></td>
</tr>
<tr>
<td>Custom Type &lt;x&gt;</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plain Paper is the factory default setting.

### Set Type menu for Manual Envelope

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Type menu for Manual Envelope</td>
<td>Lets you specify the type of envelope being manually loaded</td>
</tr>
<tr>
<td>Envelope</td>
<td></td>
</tr>
<tr>
<td>Rough Envelope</td>
<td></td>
</tr>
<tr>
<td>Custom Type &lt;x&gt;</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Envelope is the factory default setting.

### Paper Texture menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Texture menu</td>
<td>Specifies the relative texture of the paper loaded in a specific tray</td>
</tr>
<tr>
<td>Plain Texture</td>
<td>Specifies the relative texture of the paper loaded in a specific tray</td>
</tr>
<tr>
<td>Smooth</td>
<td>Note: Normal is the factory default setting.</td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
</tbody>
</table>

### Card Stock Texture

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Stock Texture</td>
<td>Specifies the relative texture of the card stock loaded in a specific tray</td>
</tr>
</tbody>
</table>
| Smooth | Notes:
- Normal is the factory default setting. |
<p>| Normal | |
| Rough | |
| Settings appear only if card stock is supported. |</p>
<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transparency Texture</strong></td>
<td>Specifies the relative texture of the transparencies loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Recycled Texture</strong></td>
<td>Specifies the relative texture of the recycled paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Labels Texture</strong></td>
<td>Specifies the relative texture of the labels loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Bond Texture</strong></td>
<td>Specifies the relative texture of the bond paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Rough is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Envelope Texture</strong></td>
<td>Specifies the relative texture of the envelopes loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Rough Envelope Texture</strong></td>
<td>Specifies the relative texture of the envelopes loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Rough is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td><strong>Letterhead Texture</strong></td>
<td>Specifies the relative texture of the letterhead paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Preprinted Texture</strong></td>
<td>Specifies the relative texture of the preprinted paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Colored Texture</strong></td>
<td>Specifies the relative texture of the colored paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Light Texture</strong></td>
<td>Specifies the relative texture of the paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
<tr>
<td><strong>Heavy Texture</strong></td>
<td>Specifies the relative texture of the paper loaded in a specific tray</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Normal is the factory default setting.</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
</tr>
</tbody>
</table>
### Rough/Cotton Texture

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rough</td>
<td>Specifies the relative texture of the paper loaded in a specific tray</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Rough is the factory default setting.</td>
</tr>
</tbody>
</table>

#### Custom Texture

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth</td>
<td>Specifies the relative texture of the custom paper loaded in a specific tray</td>
</tr>
<tr>
<td>Normal</td>
<td>Notes:</td>
</tr>
<tr>
<td>Rough</td>
<td>• Normal is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• Settings appear only if the custom type is supported.</td>
</tr>
</tbody>
</table>

### Paper Weight menu

#### Select Type

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Weight</td>
<td>Specifies the paper type</td>
</tr>
<tr>
<td>Card Stock Weight</td>
<td></td>
</tr>
<tr>
<td>Transparency Weight</td>
<td></td>
</tr>
<tr>
<td>Recycled Weight</td>
<td></td>
</tr>
<tr>
<td>Labels Weight</td>
<td></td>
</tr>
<tr>
<td>Bond Weight</td>
<td></td>
</tr>
<tr>
<td>Rough Envelope Weight</td>
<td></td>
</tr>
<tr>
<td>Letterhead Weight</td>
<td></td>
</tr>
<tr>
<td>Preprinted Weight</td>
<td></td>
</tr>
<tr>
<td>Colored Weight</td>
<td></td>
</tr>
<tr>
<td>Light Weight</td>
<td></td>
</tr>
<tr>
<td>Heavy Weight</td>
<td></td>
</tr>
<tr>
<td>Rough Cotton Weight</td>
<td></td>
</tr>
<tr>
<td>Custom &lt;x&gt; Texture</td>
<td></td>
</tr>
</tbody>
</table>

#### Set Weight

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light</td>
<td>After you select a setting for Select Type, the Set Weight menu item lets you set the weight for that type of media.</td>
</tr>
<tr>
<td>Normal</td>
<td>Notes:</td>
</tr>
<tr>
<td>Heavy</td>
<td>• Normal is the factory default setting for most items.</td>
</tr>
<tr>
<td></td>
<td>• When Light Weight is the setting selected for Select Type, Light is the only Select Weight setting available.</td>
</tr>
<tr>
<td></td>
<td>• When Heavy Weight is the setting selected for Select Type, Heavy is the only Select Weight setting available.</td>
</tr>
<tr>
<td></td>
<td>• Settings appear only if the paper is supported.</td>
</tr>
</tbody>
</table>
### Paper Loading menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Type</strong></td>
<td>Specifies the paper type</td>
</tr>
<tr>
<td>- Recycled Loading</td>
<td></td>
</tr>
<tr>
<td>- Bond Loading</td>
<td></td>
</tr>
<tr>
<td>- Letterhead loading</td>
<td></td>
</tr>
<tr>
<td>- Preprinted Loading</td>
<td></td>
</tr>
<tr>
<td>- Colored Loading</td>
<td></td>
</tr>
<tr>
<td>- Light Loading</td>
<td></td>
</tr>
<tr>
<td>- Heavy Loading</td>
<td></td>
</tr>
<tr>
<td>- Custom Loading</td>
<td></td>
</tr>
<tr>
<td><strong>Set Loading</strong></td>
<td>Specifies whether duplex (2-sided) printing is turned on</td>
</tr>
<tr>
<td>- Off</td>
<td></td>
</tr>
<tr>
<td>- Duplex</td>
<td></td>
</tr>
</tbody>
</table>

*Note: After you select the type of paper, the Set Loading menu appears.*

### Custom Types menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom Type &lt;x&gt;</strong></td>
<td>Associates a paper or specialty media type with a <em>Custom Type &lt;x&gt;</em> name or a user-defined Custom Name created from the Embedded Web Server or MarkVision™ Professional</td>
</tr>
<tr>
<td>- Paper</td>
<td></td>
</tr>
<tr>
<td>- Card Stock</td>
<td></td>
</tr>
<tr>
<td>- Transparency</td>
<td></td>
</tr>
<tr>
<td>- Rough/Cotton</td>
<td></td>
</tr>
<tr>
<td>- Labels</td>
<td></td>
</tr>
<tr>
<td>- Envelope</td>
<td></td>
</tr>
</tbody>
</table>

*Notes:*
- The Custom Name must be limited to 16 characters.
- Paper is the factory default setting.
- The custom media type must be supported by the selected tray or feeder in order for you to print from that source.

<table>
<thead>
<tr>
<th>Recycled</th>
<th>Specifies the recycled paper type loaded in a tray. This will also be the Recycled setting in other menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Paper</td>
<td></td>
</tr>
<tr>
<td>- Card Stock</td>
<td></td>
</tr>
<tr>
<td>- Transparency</td>
<td></td>
</tr>
<tr>
<td>- Labels</td>
<td></td>
</tr>
<tr>
<td>- Envelope</td>
<td></td>
</tr>
<tr>
<td>- Rough/Cotton</td>
<td></td>
</tr>
</tbody>
</table>

*Notes:*
- Paper is the factory default setting.
- The Recycled type must be supported by the selected tray or feeder in order for you to print from that source.
Universal Setup menu

These menu items are used to specify the height, width, and feed direction of the Universal Paper Size. The Universal Paper Size is a user-defined paper size. It is listed with the other paper size settings and includes similar options, such as support for duplex printing and printing multiple pages on one sheet.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units of Measure</td>
<td>Identifies the units of measure</td>
</tr>
<tr>
<td>Inches</td>
<td>Notes:</td>
</tr>
<tr>
<td>Millimeters</td>
<td>• Inches is the US factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• Millimeters is the international factory default setting.</td>
</tr>
<tr>
<td>Portrait Width</td>
<td>Sets the portrait width</td>
</tr>
<tr>
<td>3–14.17 inches</td>
<td>Notes:</td>
</tr>
<tr>
<td>76–360 mm</td>
<td>• If the width exceeds the maximum, then the printer uses the maximum width allowed.</td>
</tr>
<tr>
<td></td>
<td>• 8.5 inches is the US factory default setting. Inches can be increased in 0.01-inch increments.</td>
</tr>
<tr>
<td></td>
<td>• 216 mm is the international factory default setting. Millimeters can be increased in 1-mm increments.</td>
</tr>
<tr>
<td>Portrait Height</td>
<td>Sets the portrait height</td>
</tr>
<tr>
<td>3–14.17 inches</td>
<td>Notes:</td>
</tr>
<tr>
<td>76–360 mm</td>
<td>• If the height exceeds the maximum, then the printer uses the maximum height allowed.</td>
</tr>
<tr>
<td></td>
<td>• 14 inches is the US factory default setting. Inches can be increased in 0.01-inch increments.</td>
</tr>
<tr>
<td></td>
<td>• 356 mm is the international factory default setting. Millimeters can be increased in 1-mm increments.</td>
</tr>
<tr>
<td>Feed Direction</td>
<td>Specifies the feed direction</td>
</tr>
<tr>
<td>Short Edge</td>
<td>Notes:</td>
</tr>
<tr>
<td>Long Edge</td>
<td>• Short Edge is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• Long Edge appears only if the longest edge is shorter than the maximum length supported in the tray.</td>
</tr>
</tbody>
</table>
## Settings menu

### General Settings menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Language</strong></td>
<td>Sets the language of the text appearing on the display</td>
</tr>
<tr>
<td>English</td>
<td></td>
</tr>
<tr>
<td>Francais</td>
<td></td>
</tr>
<tr>
<td>Deutsch</td>
<td></td>
</tr>
<tr>
<td>Italiano</td>
<td></td>
</tr>
<tr>
<td>Espanol</td>
<td></td>
</tr>
<tr>
<td>Dansk</td>
<td></td>
</tr>
<tr>
<td>Norsk</td>
<td></td>
</tr>
<tr>
<td>Nederlands</td>
<td></td>
</tr>
<tr>
<td>Svenska</td>
<td></td>
</tr>
<tr>
<td>Portuguese</td>
<td></td>
</tr>
<tr>
<td>Suomi</td>
<td></td>
</tr>
<tr>
<td>Russian</td>
<td></td>
</tr>
<tr>
<td>Polski</td>
<td></td>
</tr>
<tr>
<td>Magyar</td>
<td></td>
</tr>
<tr>
<td>Turkce</td>
<td></td>
</tr>
<tr>
<td>Cesky</td>
<td></td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td></td>
</tr>
<tr>
<td>Korean</td>
<td></td>
</tr>
<tr>
<td>Japanese</td>
<td></td>
</tr>
<tr>
<td><strong>Eco-Mode</strong></td>
<td>Note: Off is the factory default setting.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Energy</td>
<td></td>
</tr>
<tr>
<td>Paper</td>
<td></td>
</tr>
<tr>
<td>Energy/Paper</td>
<td></td>
</tr>
<tr>
<td><strong>Quiet Mode</strong></td>
<td>Note: Off is the factory default setting.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Run Initial Setup</strong></td>
<td>Before running the Setup Wizard, the default setting is Yes, but after running the wizard, the default setting is No.</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>Alarm</strong></td>
<td>The display shows a message when the toner is low</td>
</tr>
<tr>
<td>Cartridge Alarm</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Single</td>
<td></td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>• Off is the factory default setting. The Toner is low message will appear as a warning.</td>
<td></td>
</tr>
<tr>
<td>• Single means the Toner is low message will appear and the indicator light will blink red.</td>
<td></td>
</tr>
<tr>
<td>Menu item</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Timeouts** | **Power Saver**  
Disabled  
1–240  
Sets the amount of time in minutes the printer waits after a job is printed before it goes into a reduced power state  
**Note:** Disabled does not appear unless Energy Conserve is Off.  |
| **Timeouts** | **Print Timeout**  
Disabled  
1–255  
Sets the amount of time in seconds the printer waits to receive an end-of-job message before canceling the remainder of the print job  
**Notes:**  
- 90 seconds is the factory default setting.  
- When the timer expires, any partially printed page still in the printer is printed, and then the printer checks to see if any new print jobs are waiting.  
- Print Timeout is available only when using PCL. This setting has no effect on PostScript emulation print jobs.  |
| **Timeouts** | **Wait Timeout**  
Disabled  
15–65535  
Sets the amount of time in seconds the printer waits for additional data before canceling a print job  
**Notes:**  
- 40 seconds is the factory default setting.  
- Wait Timeout is available only when the printer is using PostScript emulation. This setting has no effect on PCL emulation print jobs.  |
| **Print Recovery** | **Auto Continue**  
Disabled  
5–255  
Lets the printer automatically continue printing from certain offline situations when not resolved within the specified time period  
**Notes:**  
- Disabled is the factory default setting.  
- 5–255 is a range of time in seconds.  |
| **Print Recovery** | **Jam Recovery**  
On  
Off  
Auto  
Specifies whether the printer reprints jammed pages  
**Notes:**  
- Auto is the factory default setting. The printer reprints jammed pages unless the memory required to hold the pages is needed for other printer tasks.  
- On sets the printer to always reprint jammed pages.  
- Off sets the printer to never reprint jammed pages.  |
| **Print Recovery** | **Page Protect**  
On  
Off  
Lets the printer successfully print a page that may not have printed otherwise  
**Notes:**  
- Off is the factory default setting. Off prints a partial page when there is not enough memory to print the whole page.  
- On sets the printer to process the whole page so that the entire page prints.  |
### Setup menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Factory Defaults** | Returns the printer settings to the factory default settings  
Do Not Restore  
Restore Now                                                                                     |

**Notes:**
- Do Not Restore is the factory default setting. Do Not Restore keeps the user-defined settings.
- Restore Now returns all printer settings to the factory default settings except those in the Network/Ports menu. All downloads stored in RAM are deleted. Downloads stored in flash memory are not affected.

<table>
<thead>
<tr>
<th><strong>Setup menu</strong></th>
<th></th>
</tr>
</thead>
</table>
| **Printer Language** | Sets the default printer language  
PCL Emulation  
PS Emulation                                                      |

**Notes:**
- PostScript emulation uses a PS interpreter for processing print jobs. PCL emulation uses a PCL interpreter for processing print jobs.
- The factory default printer language is PCL Emulation.
- Setting a printer language as the default does not prevent a software program from sending print jobs that use another printer language.

<table>
<thead>
<tr>
<th><strong>Print Area</strong></th>
<th></th>
</tr>
</thead>
</table>
| Normal         | Sets the logical and physical printable area  
Whole Page                                                                      |

**Notes:**
- Normal is the factory default setting. When attempting to print data in the non-printable area defined by the Normal setting, the printer clips the image at the boundary.
- The Whole Page setting allows the image to be moved into the non-printable area defined by the Normal setting, but the printer clips the image at the Normal setting boundary.
- The Whole Page setting affects only pages printed using a PCL 5e interpreter. This setting has no effect on pages printed using the PCL XL or PostScript interpreter.

<table>
<thead>
<tr>
<th><strong>Download Target</strong></th>
<th></th>
</tr>
</thead>
</table>
| RAM                 | Sets the storage location for downloads  
Flash                                                                       |

**Notes:**
- RAM is the factory default setting.
- Flash appears only if a flash option is installed.
- Storing downloads in RAM is temporary.
### Menu item | Description
--- | ---
**Resource Save**  
Off  
On | Specifies how the printer handles temporary downloads, such as fonts and macros stored in RAM, when the printer receives a job that requires more memory than is available  
**Notes:**  
- Off is the factory default setting. Off sets the printer to retain the downloads only until memory is needed. Downloads are deleted in order to process print jobs.  
- The On setting retains the downloads during language changes and printer resets. If the printer runs out of memory, downloads are not deleted.  

**Print All Order**  
Alphabetical  
Oldest First  
Newest First | Sets the order in which the print jobs are printed.  
**Note:** Alphabetical is the factory default setting.

### Finishing menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Sides (Duplex)**  
1 sided  
2 sided | Specifies whether duplex (2-sided) printing is set as the default for all print jobs  
**Notes:**  
- 1 sided is the factory default setting.  
- To set 2-sided printing from the software program: for Windows users, click File → Print, and then click Properties, Preferences, Options, or Setup; for Macintosh users, choose File > Print, and then adjust the settings from the Print dialog and pop-up menus. |
| **Duplex Binding**  
Long Edge  
Short Edge | Defines the way duplexed pages are bound and how the printing on the back of the page is oriented in relation to the printing on the front of the page  
**Notes:**  
- Long Edge is the factory default setting.  
- Long Edge specifies that binding be placed on the left edge of portrait pages and the top edge of landscape pages.  
- Short Edge specifies that binding be placed on the top edge of portrait pages and the left edge of landscape pages. |
| **Copies**  
1–999 | Specifies a default number of copies for each print job  
**Note:** 1 is the factory default setting. |
| **Blank Pages**  
Do Not Print  
Print | Specifies whether blank pages are inserted in a print job  
**Note:** Do Not Print is the factory default setting. |
<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collate</td>
<td>Stacks the pages of a print job in sequence when printing multiple copies</td>
<td>• Off is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The On setting stacks the print job sequentially.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Both settings print the entire job the number of times specified by the Copies menu setting.</td>
</tr>
<tr>
<td></td>
<td>Off (1,1,1,2,2,2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On (1,2,1,2,1,2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The On setting stacks the print job sequentially.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Both settings print the entire job the number of times specified by the Copies menu setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Separator Sheets</td>
<td>Specifies whether blank separator sheets are inserted</td>
<td>• None is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Between Copies inserts a blank sheet between each copy of a print job if Collation is set to On. If Collation is set to Off, a blank page is inserted between each set of printed pages, such as after all page 1’s and after all page 2’s.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Between Jobs inserts a blank sheet between print jobs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Between Pages inserts a blank sheet between each page of the print job. This setting is useful when printing transparencies or inserting blank pages in a document for notes.</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Between Copies</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Between Jobs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Between Pages</td>
<td></td>
</tr>
<tr>
<td>Separator Source</td>
<td>Specifies the paper source for separator sheets</td>
<td>• Tray 1 (standard tray) is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• From the Paper menu, Configure MP must be set to Cassette in order for Multi-Purpose Feeder to appear as a menu setting.</td>
</tr>
<tr>
<td></td>
<td>Tray &lt;x&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multi-Purpose Feeder</td>
<td></td>
</tr>
<tr>
<td>N-up (pages-side)</td>
<td>Specifies that multiple-page images be printed on one side of a sheet of paper</td>
<td>• Off is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number selected is the number of page images that will print per side.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12-Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>16-Up</td>
<td></td>
</tr>
<tr>
<td>N-up Ordering</td>
<td>Specifies the positioning of multiple-page images when using N-up (pages-sides)</td>
<td>• Horizontal is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Positioning depends on the number of images and whether the images are in portrait or landscape orientation.</td>
</tr>
<tr>
<td></td>
<td>Horizontal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reverse Horizontal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reverse Vertical</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td></td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the orientation of a multiple-page sheet</td>
<td><strong>Note:</strong> Auto is the factory default setting. The printer chooses between portrait and landscape.</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Portrait</td>
<td></td>
</tr>
</tbody>
</table>
### N-up Border

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Prints a border around each page image when using N-up (pages-sides)</td>
</tr>
<tr>
<td>Solid</td>
<td>Note: None is the factory default setting.</td>
</tr>
</tbody>
</table>

### Quality menu

#### Menu item

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Resolution</td>
</tr>
<tr>
<td>300 dpi</td>
</tr>
<tr>
<td>600 dpi</td>
</tr>
<tr>
<td>1200 dpi</td>
</tr>
<tr>
<td>1200 Image Q</td>
</tr>
<tr>
<td>2400 Image Q</td>
</tr>
</tbody>
</table>

#### Description

Specifies the printed output resolution

- **Note:** 600 dpi is the factory default setting. The printer driver default is 2400 Image Q.

<table>
<thead>
<tr>
<th>Pixel Boost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Fonts</td>
</tr>
<tr>
<td>Horizontally</td>
</tr>
<tr>
<td>Vertically</td>
</tr>
<tr>
<td>Both Directions</td>
</tr>
<tr>
<td>Isolated</td>
</tr>
</tbody>
</table>

Enhances the printed quality of small fonts and graphics

- **Notes:**
  - Off is the factory default setting.
  - Fonts applies this setting only to text.
  - Horizontally darkens horizontal lines of text and images.
  - Vertically darkens vertical lines of text and images.
  - Both Directions darkens horizontal and vertical lines on text and images.
  - Isolated darkens isolated text and images.

<table>
<thead>
<tr>
<th>Toner Darkness</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–10</td>
</tr>
</tbody>
</table>

Lightens or darkens the printed output

- **Notes:**
  - 8 is the factory default setting.
  - Selecting a smaller number can help conserve toner.

<table>
<thead>
<tr>
<th>Enhance Fine Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
</tr>
<tr>
<td>On</td>
</tr>
</tbody>
</table>

Enables a print mode preferable for files such as architectural drawings, maps, electrical circuit diagrams, and flow charts

- **Notes:**
  - Off is the factory default setting.
  - To set Enhance Fine Lines using the Embedded Web Server, type the network printer IP address in a browser window.

<table>
<thead>
<tr>
<th>Gray Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
</tr>
<tr>
<td>Off</td>
</tr>
</tbody>
</table>

Adjusts the gray value of printed output

- **Note:** Auto is the factory default setting.

<table>
<thead>
<tr>
<th>Brightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>-6 to +6</td>
</tr>
</tbody>
</table>

Adjusts or darkens printed output and conserves toner

- **Notes:**
  - 0 is the factory default setting.
  - A negative value will darken text, images, and graphics. A positive value will lighten them and conserve toner.
## Menu item | Description
--- | ---
Contrast | Adjusts the degree of difference between levels of gray in printed output
0–5 | Notes:

- 0 is the factory default setting.
- Higher settings show more difference between levels of gray.

### PostScript menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
</table>

#### Print PS Error

- Off
- On

Prints a page containing the PostScript error

Note: Off is the factory default setting.

#### Font Priority

- Resident
- Flash

Establishes the font search order

Notes:

- Resident is the factory default setting.
- A formatted optional flash memory card must be installed in the printer and operating properly for this menu item to be available.
- The optional flash memory card cannot be Read/Write, Write, or password protected.
- Job Buffer Size must not be set to 100%.

### PCL Emul menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
</table>

#### Font Source

- Resident
- Download
- Flash
- All

Specifies the set of fonts available

Notes:

- Resident is the factory default setting. It shows the factory default set of fonts downloaded into RAM.
- Download appears only if downloaded fonts exist. It shows all the fonts downloaded into RAM.
- Flash appears only if a flash option containing fonts is installed.
- A flash option must be properly formatted and cannot be Read/Write, Write, or password protected.
- All shows all fonts available to any option.

#### Font Name

<x>

Displays a specific font and the option where it is stored

Notes:

- Courier is the factory default setting.
- The font source abbreviation is R for Resident, M1 for Flash, and S for Download.

Understanding printer menus
<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symbol Set</strong></td>
<td>Specifies the font ID and font name that compose each symbol set</td>
</tr>
<tr>
<td>&lt;x&gt;</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td></td>
<td>• 10U PC-8 is the US factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• 12U PC-850 is the international factory default setting.</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Changes the point size for scalable typographic fonts</td>
</tr>
<tr>
<td>Point Size</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>1.00–1008.00</td>
<td>• 12 is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• Point Size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.</td>
</tr>
<tr>
<td></td>
<td>• Point sizes can be increased or decreased in 0.25-point increments.</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Specifies the font pitch for scalable monospaced fonts</td>
</tr>
<tr>
<td>Pitch</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>0.08–100</td>
<td>• 10 is the factory default setting.</td>
</tr>
<tr>
<td></td>
<td>• Pitch refers to the number of fixed-space characters per inch (cpi).</td>
</tr>
<tr>
<td></td>
<td>• Pitch can be increased or decreased in 0.01-cpi increments.</td>
</tr>
<tr>
<td></td>
<td>• For nonscalable monospaced fonts, the pitch appears on the display but cannot be changed.</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Specifies the orientation of text and graphics on the page</td>
</tr>
<tr>
<td>Orientation</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>Portrait</td>
<td>• Portrait is the factory default setting.</td>
</tr>
<tr>
<td>Landscape</td>
<td>• Portrait prints text and graphics parallel to the short edge of the page.</td>
</tr>
<tr>
<td></td>
<td>• Landscape prints text and graphics parallel to the long edge of the page.</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Specifies the number of lines that print on each page</td>
</tr>
<tr>
<td>Lines per Page</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>1–255</td>
<td>• 60 is the US factory default setting. 64 is the international factory default setting.</td>
</tr>
<tr>
<td>60</td>
<td>• The printer sets the amount of space between each line based on the Lines per Page, Paper Size, and Orientation settings. Select the desired Paper Size and Orientation before setting Lines per Page.</td>
</tr>
<tr>
<td>64</td>
<td></td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Sets the printer to print on A4-size paper</td>
</tr>
<tr>
<td>A4 Width</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>198 mm</td>
<td>• 198 mm is the factory default setting.</td>
</tr>
<tr>
<td>203 mm</td>
<td>• The 203-mm setting sets the width of the page to allow the printing of eighty 10-pitch characters.</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Specifies whether the printer automatically performs a carriage return (CR) after a line feed (LF) control command</td>
</tr>
<tr>
<td>Auto CR after LF</td>
<td><strong>Note:</strong> Off is the factory default setting.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Menu item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>PCL Emulation Settings</strong></td>
<td>Specifies whether the printer automatically performs a line feed (LF) after a carriage return (CR) control command</td>
</tr>
<tr>
<td>Auto LF after CR</td>
<td><strong>Note:</strong> Off is the factory default setting.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Tray Renumber</strong></td>
<td>Configures the printer to work with printer software or programs that use different source assignments for trays, drawers, and feeders</td>
</tr>
<tr>
<td>Assign MP Feeder</td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>Off</td>
<td>• Off is the factory default setting.</td>
</tr>
<tr>
<td>None</td>
<td>• None is not an available selection. It is displayed only when it is selected by the PCL 5 interpreter.</td>
</tr>
<tr>
<td>0–199</td>
<td>• None ignores the Select Paper Feed command.</td>
</tr>
<tr>
<td>Assign Tray &lt;x&gt;</td>
<td>• 0–199 allows a custom setting to be assigned.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>0–199</td>
<td></td>
</tr>
<tr>
<td>Assign Manual Paper</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>0–199</td>
<td></td>
</tr>
<tr>
<td>Assign Man Env</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>0–199</td>
<td></td>
</tr>
<tr>
<td><strong>Tray Renumber</strong></td>
<td>Displays the factory default setting assigned to each tray, drawer, or feeder</td>
</tr>
<tr>
<td>View Factory Def</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td><strong>Tray Renumber</strong></td>
<td>Returns all tray, drawer, and feeder assignments to the factory default settings</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
Maintaining the printer

Periodically, certain tasks are required to maintain optimum print quality.

Cleaning the exterior of the printer

1. Make sure that the printer is turned off and unplugged from the wall outlet.

   **CAUTION—SHOCK HAZARD:** To avoid the risk of electric shock when cleaning the exterior of the printer, unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2. Remove all paper from the printer.

3. Dampen a clean, lint-free cloth with water.

   **Warning—Potential Damage:** Do not use household cleaners or detergents, as they may damage the finish of the printer.

4. Wipe only the outside of the printer.

   **Warning—Potential Damage:** Using a damp cloth to clean the interior may cause damage to your printer.

5. Make sure all areas of the printer are dry before beginning a new print job.

Storing supplies

Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you are ready to use them.

Do not expose supplies to:

- Direct sunlight
- Temperatures above 35°C (95°F)
- High humidity above 80%
- Salty air
- Corrosive gases
- Heavy dust

Checking the status of supplies

Checking the status of supplies from a network computer

**Note:** The computer must be connected to the same network as the printer.

1. Type the printer IP address into the address field of your Web browser.

   **Note:** If you do not know the IP address of the printer, print a network setup page and locate the IP address in the TCP/IP section.

2. Click **Device Status**. The Device Status page appears, displaying a summary of supply levels.
Ordering supplies

To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies dealers in your area. In other countries or regions, visit the Lexmark Web Site at www.lexmark.com or contact the place where you purchased the printer.

Note: All life estimates for printer supplies assume printing on letter- or A4-size plain paper.

Ordering toner cartridges

When 88 Cartridge is Low appears or when the print becomes faded, you may be able to extend the life of the toner cartridge:

1. Remove the toner cartridge.
2. Firmly shake the cartridge side-to-side and front-to-back several times to redistribute toner.
3. Reinsert the cartridge and continue printing.

Note: Repeat this procedure multiple times until the print remains faded, and then replace the cartridge.

Recommended toner cartridges and part numbers

<table>
<thead>
<tr>
<th>Part name</th>
<th>Lexmark Return Program Cartridge</th>
<th>Regular cartridge</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For the US and Canada</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>E260A11A</td>
<td>E260A21A</td>
</tr>
<tr>
<td><strong>For Europe, the Middle East, and Africa</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>E260A11E</td>
<td>E260A21E</td>
</tr>
<tr>
<td><strong>For the Asia Pacific Region, including Australia, New Zealand, and India</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>E260A11P</td>
<td>E260A21P</td>
</tr>
<tr>
<td><strong>For Latin America</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>E260A11L</td>
<td>E260A21L</td>
</tr>
</tbody>
</table>
Ordering a photoconductor kit

Depending on your printer model, the printer issues a message or a light sequence to let you know the photoconductor kit is near its end of life. At this time, order a photoconductor kit. You can also see the status of the photoconductor kit by printing a network setup page.

<table>
<thead>
<tr>
<th>Part name</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoconductor kit</td>
<td>E260X22G</td>
</tr>
</tbody>
</table>

Replacing supplies

Replacing the toner cartridge

**Light sequence**

**Toner is low**

- 📜/🗑 - On
- ⚛ - On

When the **Toner is Low** light sequence appears, or when you experience faded print, remove the toner cartridge. Firmly shake it side-to-side and front-to-back several times to redistribute the toner, and then reinsert it and continue printing. When shaking the cartridge no longer improves the print quality, replace the toner cartridge.

**Note:** You can check to see approximately how much toner is left in your cartridge by printing a menu settings page.
To replace the toner cartridge:

1. Open the front door by pressing the button on the left side of the printer and lowering the door.

2. Press the button on the base of the photoconductor kit, and then pull the toner cartridge out using the handle.

3. Unpack the new toner cartridge.

   Warning—Potential Damage: When replacing a toner cartridge, do not leave the new cartridge exposed to direct light for an extended period of time. Extended light exposure can cause print quality problems.

4. Rotate the cartridge in all directions to distribute the toner.
5 Install the new toner cartridge by aligning the rollers on the toner cartridge with the arrows on the tracks of the photoconductor kit. Push the toner cartridge in until it clicks into place.

6 Close the front door.

Replacing the photoconductor kit

The printer displays the Photoconductor life warning or Replace photoconductor light sequence when the photoconductor kit reaches the page maximum.

Light sequences

Photoconductor life warning

- On
Replace photoconductor

When any of the light sequences occur, order a new photoconductor kit. While the printer may continue to function properly after the photoconductor kit has reached its official end-of-life, print quality significantly decreases.

Note: The photoconductor kit is a single item.

To replace the photoconductor kit:

1. Turn off the printer.
2. Pull the photoconductor kit and toner cartridge together as a unit out of the printer by pulling on the toner cartridge handle.

   Note: The photoconductor kit and toner cartridge form a unit.
Place the unit on a flat, clean surface.

3 Press the button on the base of the photoconductor kit, and then pull the toner cartridge up and out using the handle.

4 Unpack the new photoconductor kit.
   **Warning—Potential Damage:** Be careful not to touch the photoconductor drum. Doing so may affect the print quality of future print jobs.

5 Insert the toner cartridge into the photoconductor kit by aligning the rollers on the toner cartridge with the tracks. Push the toner cartridge in until it *clicks* into place.
6 Install the unit into the printer by aligning the arrows on the guides of the unit with the arrows in the printer. Push the unit fully in.

7 After replacing the photoconductor kit, reset the photoconductor counter:
   Open the front door and then press and hold \[\times\] until all the lights cycle.
   
   **Warning—Potential Damage:** Resetting the photoconductor counter without replacing the photoconductor kit may damage your printer and void your warranty.

8 Close the front door.

**Moving the printer**

**Before moving the printer**

**CAUTION—POTENTIAL INJURY:** Before moving the printer, follow these guidelines to avoid personal injury or printer damage:

- Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.
- Disconnect all cords and cables from the printer before moving it.
- Lift the printer off the optional drawer, and set it aside instead of trying to lift the drawer and printer at the same time.

  **Note:** Use the handholds located on both sides of the printer to lift it off the optional drawer.

Use only the power cord provided with this product or the manufacturer’s authorized replacement.

**Warning—Potential Damage:** Damage to the printer caused by improper moving is not covered by the printer warranty.

**Moving the printer to another location**

The printer and options can be safely moved to another location by following these precautions:

- Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any cart used to move the options must have a surface able to support the dimensions of the options.
- Keep the printer in an upright position.
- Avoid severe jarring movements.
Shipping the printer

When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
Administrative support

Finding advanced networking and administrator information


Restoring the factory default settings

If your printer is connected to a computer by a USB or parallel cable, use the Local Printer Settings Utility for Windows or Printer Settings for Macintosh.

1 Open the utility.
2 Do one of the following:
   • From the Local Printer Settings Utility menu bar, click Actions ➔ Restore Factory Defaults.
   • From Printer Settings, click Factory Defaults.

Warning—Potential Damage: Restore Factory Defaults returns all printer settings to the factory default settings except the Port menu settings. All downloads stored in RAM are deleted.

You can also restore factory default settings using the printer control panel. For instructions, print a printer settings configuration sheet.
Clearing jams

Avoiding jams

The following hints can help you avoid jams:

Paper tray recommendations

- Make sure the paper lies flat in the tray.
- Do not remove a tray while the printer is printing.
- Do not load a tray while the printer is printing. Load it prior to printing, or wait for a prompt to load it.
- Do not load too much paper. Make sure the stack height does not exceed the indicated maximum height.
- Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing too tightly against the paper or envelopes.
- Push the tray in firmly after loading paper.

Paper recommendations

- Use only recommended paper or specialty media.
- Do not load wrinkled, creased, damp, bent, or curled paper.
- Flex, fan, and straighten paper before loading it.
- Do not use paper that has been cut or trimmed by hand.
- Do not mix paper sizes, weights, or types in the same stack.
- Make sure all sizes and types are set correctly in the printer control panel menus.
- Store paper per the manufacturer's recommendations.

Accessing jam areas

Open doors and remove trays to access jam areas. The following illustration shows possible jam areas:
## Understanding jam lights and access locations

The jam lights and messages are shown, along with brief instructions on how to access each jam.

**Note:** The jam messages listed appear on the virtual display of the Embedded Web Server.

<table>
<thead>
<tr>
<th>Access point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Push button to open the front door. Inside this door is the unit housing the toner cartridge and photoconductor kit.</td>
</tr>
<tr>
<td>2</td>
<td>Standard exit bin</td>
</tr>
<tr>
<td>3</td>
<td>Front door</td>
</tr>
<tr>
<td>4</td>
<td>Manual feeder door</td>
</tr>
<tr>
<td>5</td>
<td>Standard 250-sheet tray (Tray 1)</td>
</tr>
<tr>
<td>6</td>
<td>Optional tray (Tray 2)</td>
</tr>
<tr>
<td>7</td>
<td>Rear door</td>
</tr>
</tbody>
</table>

### 200.yy Paper jam

- **!** - On
- **?</** - On
- **?** - On
- **G** - On

Clearing jams
Try one of the following:

- Remove Tray 1.
- Open the front door, and then remove the photoconductor kit and toner cartridge unit.

201.yy Paper jam

- On
- On
- On
- On

Open the front door, and then remove the photoconductor kit and toner cartridge unit.

202.yy Paper jam

- On
- On
- On
- On

Open the front door, and then open the rear door.
Open the front door, and then open the rear door.

Try one of the following:

- Remove Tray 1, and then depress the lever.
- Open the front door, and then open the rear door.

Try one of the following:

- Open the front door, and then open the rear door.
- Remove Tray 1, and then depress the lever.
235.yy Paper jam

$t$ - On

- Blinking

$\square$ - Blinking

$\square$ - On

Remove the jam from the standard exit bin.

24x.yy Paper jam

$t$ - On

- On

$\square$ - On

$\Box/\Box$ - On

$\square$ - On

Try one of the following:

- Remove Tray 1.
- Open the front door, and then remove the photoconductor kit and toner cartridge unit.
- Remove Tray 2.
251.yy Paper jam

- On
- On
- On
- On
- On

Remove the jam from the manual feeder.

**Clearing jams behind the photoconductor kit and toner cartridge**

1. Push the release button, and then lower the front door.
2 Lift and pull the unit containing the photoconductor kit and the toner cartridge out of the printer. Set the unit aside on a flat, clean surface.

Warning—Potential Damage: Do not touch the photoconductor on the underside of the photoconductor kit. Use the cartridge handle whenever you are holding the cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow the surface to cool before touching.

3 Remove the jammed paper.

Note: If the paper is not easy to remove, then open the rear door to remove the paper.

4 Align and reinstall the unit.
5  Close the front door.
6  Press ▶️ to continue printing.

**Clearing jams from the standard exit bin**

A duplex print job was sent to the printer using a paper size not supported for duplex printing. A sheet is jammed in the standard exit bin.

To remove the jam, gently pull the sheet straight out of the standard exit bin.

![Image of a printer with a sheet jammed in the standard exit bin]

**Clearing jams from Tray 1**

To see whether paper is jammed in or behind Tray 1, the standard tray:

1  Remove Tray 1.
2 Remove the jammed paper.

3 If necessary, depress the lever to free the paper and remove the jam.

4 Insert the tray.

5 Press ➔ to continue printing.
Clearing jams from Tray 2

To see whether paper is jammed in or behind Tray 2:

1. Remove Tray 2.

2. Remove the jammed paper.
3 Insert the tray.

4 Press ▶ to continue printing.

Clearing jams in the manual feeder

Paper jammed in the manual feeder can usually be grasped and pulled straight out. If the jam cannot be removed this way, check for jammed paper behind the photoconductor kit and toner cartridge unit. For more information, see “Clearing jams behind the photoconductor kit and toner cartridge” on page 99.
Clearing jams behind the rear door

If the paper is exiting the printer, pull the paper out. If the paper is not exiting the printer:

1. Push the release button, and then lower the front door.

2. Pull open the rear door.

The paper may be jammed with one end caught in the standard exit bin.

⚠️ **CAUTION—HOT SURFACE:** The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow the surface to cool before touching.
3 Remove the jammed paper.

4 Close both the front and rear doors.

5 Press > to continue printing.
Troubleshooting

Understanding printer messages

Close door
Close the front door of the printer.

Load <input src> with <custom type name>
Try one or more of the following:
- Load the specified paper to clear the message and continue printing.
- Cancel the current job.

Load <input src> with <custom string>
Try one or more of the following:
- Load the specified paper in the manual feeder, and then press ▶ to continue printing.
- Cancel the current job.

Load <input src> with <size>
Try one or more of the following:
- Load the paper tray or other source with the correct paper type and size.
- Cancel the current job.

Load <input src> with <type> <size>
Try one or more of the following:
- Load the paper tray or other source with the correct paper type and size.
- Cancel the current job.

Load manual feeder with <type> <size>
Try one or more of the following:
- Load the manual feeder with the correct paper type and size.
- Press ▶ to continue printing.
  - The printer manually overrides the request, and then prints from an automatically selected tray.
- Cancel the current job.
Load manual feeder with <custom type name>

Try one or more of the following:
- Load the manual feeder with the correct paper type and size.
- Press > to continue printing.
  The printer manually overrides the request, and then paper prints from an automatically selected tray.
- Cancel the current job.

Load manual feeder with <custom string>

Try one or more of the following:
- Load the manual feeder with the correct paper type and size.
- Press > to continue printing.
  The printer manually overrides the request, and then paper prints from an automatically selected tray.
- Cancel the current job.

Remove paper from standard output bin

Remove the stack of paper from the standard exit bin.

31 Defective cartridge

The toner cartridge is not functioning properly.

Try one or more of the following:
- Remove the toner cartridge, and then reinstall it.
- Remove the toner cartridge, and then install a new one.

32.yy Replace unsupported cartridge

Remove the toner cartridge, and then install a supported one.

58 Too many flash options installed

Try one or more of the following:
- Turn the printer off, and then remove extra flash options:
  1. Turn the printer off.
  2. Unplug the power cord from the wall outlet.
  3. Remove the excess flash memory.
  4. Connect the power cord to a properly grounded outlet.
  5. Turn the printer back on.
- Press > to clear the message and continue printing.
58 Too many trays attached

1. Turn the printer off.
2. Unplug the power cord from the wall outlet.
   
   **Note:** Optional trays lock together when stacked. Remove stacked trays one at a time from the top down.
3. Remove the additional tray(s).
4. Connect the power cord to a properly grounded outlet.
5. Turn the printer back on.

59 Incompatible tray <x>

Only options designed specifically for this printer are supported.

Try one or more of the following:
- Remove the tray.
- Press ▶ to continue printing.

88 Replace toner

Try one or more of the following:
- Replace the toner cartridge.
- Press ▶ to continue printing.

Solving basic printer problems

If there are basic printer problems, or the printer is unresponsive, make sure:
- The power cord is plugged into the printer and a properly grounded electrical outlet.
- The electrical outlet is not turned off by any switch or breaker.
- The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.
- Other electronic equipment plugged into the outlet is working.
- The printer is turned on. Check the printer power switch.
- The printer cable is securely attached to the printer and the host computer, print server, option, or other network device.
- All options are properly installed.
- The printer driver settings are correct.

Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then turn the printer back on. This often fixes the problem.
Solving printing problems

Jobs do not print

These are possible solutions. Try one or more of the following:

MAKE SURE THE PRINTER IS READY TO PRINT

Make sure the light is on before sending a job to print.

CHECK TO SEE IF THE STANDARD EXIT BIN IS FULL

Remove the stack of paper from the standard exit bin.

CHECK TO SEE IF THE TRAY IS EMPTY

Load paper in the tray.

MAKE SURE THE CORRECT PRINTER SOFTWARE IS INSTALLED

Verify that you installed the correct printer software for your printer model.

Click Install printer and software on the Software and Documentation CD to check which software is installed. Make sure the model number of the software matches the model number of your printer.

To verify that the printer software is the most current, check the Lexmark Web site at www.lexmark.com.

MAKE SURE THE PRINTER IS CONNECTED TO THE NETWORK

Print a network setup page and check that the status shows Connected. If the status is Not Connected, check the network cables, and then try printing the network setup page again. Contact your system support person to make sure the network is functioning correctly.

Copies of the printer software are also available on the Lexmark Web site at www.lexmark.com.

MAKE SURE YOU ARE USING A RECOMMENDED USB, PARALLEL, OR ETHERNET CABLE

For more information, visit the Lexmark Web site at www.lexmark.com.

MAKE SURE PRINTER CABLES ARE SECURELY CONNECTED

Check the cable connections to the printer to make sure they are secure. For more information, see the setup documentation that came with the printer.
Multiple-language PDFs do not print

The documents contain unavailable fonts.

1 Open the document you want to print in Adobe Acrobat.
2 Click the printer icon.
   The Print dialog appears.
3 Select Print as image.
4 Click OK.

Job takes longer than expected to print

The job is too complex.
Reduce the complexity of your print job by eliminating the number and size of fonts, the number and complexity of images, and the number of pages in the job.

Job prints from the wrong tray or on the wrong paper

These are possible solutions. Try one or more of the following:

CHECK THE PAPER SIZE AND PAPER TYPE SETTINGS

From the Paper menu, make sure the Paper Size and Paper Type settings match the paper loaded in the trays. To access the Paper menu, do one of the following:

- If the printer is on a network, access the Embedded Web Server by typing the IP address of the printer in the address bar of a Web browser. From the Settings tab, click Paper Menu
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.

CHECK THE PAPER TAB SETTINGS IN YOUR OPERATING SYSTEM

Open Print Properties in a Windows operating system or the print dialog in a Macintosh operating system. Make sure the Input options settings for Paper size, Paper tray, and Paper type correspond with the paper loaded in the tray.
Incorrect characters print

Hex Trace mode

Make sure the printer is not in Hex Trace mode. If the “Hex Trace mode” light sequence appears, you must exit Hex Trace mode before you can print your job. To exit Hex Trace mode, turn the printer off and back on.

Tray linking does not work

Make sure to do all of the following:

- Load both Tray 1 and Tray 2 with the same paper size and type.
- From Print Properties or the print dialog, change the Paper source to Automatically select.

Large jobs do not collate

These are possible solutions. Try one or more of the following:

CHECK THE COLLATE SETTING

From the Finishing menu, make sure Collate is On. To access the Finishing menu, do one of the following:

- If the printer is on a network, access the Embedded Web Server by typing the printer IP address into the address field of your Web browser. From the Settings screen, click Finishing Menu.
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.

CHECK THE PAPER TAB SETTINGS IN YOUR OPERATING SYSTEM

Open Print Properties in a Windows operating system or the print dialog in a Macintosh operating system. Make sure the “Page layout” setting for “Collate copies” is On, or the Collate check box is selected.

Note: Clearing the Collate check box overrides the setting in the Finishing menu.

REDUCE THE COMPLEXITY OF THE PRINT JOB

Reduce the complexity of the print job by eliminating the number and size of fonts, the number and complexity of images, and the number of pages in the job.
MAKE SURE THE PRINTER HAS ENOUGH MEMORY
   Add printer memory.

Solving option problems

Option does not operate correctly or quits after it is installed
   These are possible solutions. Try one or more of the following:

RESET THE PRINTER
   Turn the printer off, wait for about 10 seconds, and then turn the printer on.

CHECK TO SEE IF THE OPTION IS CONNECTED TO THE PRINTER
   1 Turn the printer off.
   2 Unplug the printer from the wall outlet.
   3 Check the connection between the option and the printer.

MAKE SURE THE OPTION IS INSTALLED
   Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option is not listed, reinstall it.

MAKE SURE THE OPTION IS SELECTED
   From the program you are using, select the option. Mac OS 9 users should make sure the printer is set up in the Chooser.

Drawers
   These are possible solutions. Try one or more of the following:

MAKE SURE THE PAPER IS LOADED CORRECTLY
   1 Pull the tray completely out.
   2 Check for paper jams or misfeeds.
   3 Make sure the guides are aligned against the edges of the paper.
   4 Insert the tray.

RESET THE PRINTER
   Turn the printer off, wait about 10 seconds, and then turn the printer on.
Memory card
Make sure the memory card is securely connected to the printer system board.

Solving paper feed problems

Paper frequently jams
These are possible solutions. Try one or more of the following:

CHECK THE PAPER
Use recommended paper or specialty media. For more information, see “Paper and specialty media guide” on page 50.

FLEX, FAN, AND STRAIGHTEN THE PAPER BEFORE LOADING IT IN THE TRAY

MAKE SURE THERE IS NOT TOO MUCH PAPER IN THE TRAY
Make sure the stack of paper you load does not exceed the maximum stack height indicated in the tray.

CHECK THE GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
- Load paper from a fresh package.
- Store paper in its original wrapper until you use it.

Paper jam lights remain on after jam is cleared
The paper path is not clear. Clear jammed paper from the entire paper path, and then close any open doors.
Page that jammed does not reprint after the jam is cleared

Jam Recovery is set to Off. Do one of the following to set Jam Recovery to Auto or On:

- If the printer is on a network, access the Embedded Web Server:
  1. Type the printer IP address into the address field of your Web browser.
     
     **Note:** If you do not know the IP address of the printer, print a network setup page and locate the IP address in the TCP/IP section.
  2. From the Settings tab, make sure Jam Recovery is set to Auto or On, and then click **Submit**.
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software. From the Setup menu, make sure Jam Recovery is set to Auto or On.

Solving print quality problems

The information in the following topics may help you solve print quality problems. If these suggestions still do not correct the problem, call Customer Support. You may have a printer part that requires adjustment or replacement.

Isolating print quality problems

Print the print quality test pages to isolate print quality problems.

1. Turn the printer off, and then open the front door.
2. Press and hold while turning the printer on.
4. Close the front door. The light sequence that represents the Home menu appears.

   - On
   - On
   - On

5. Press and release until you see the light sequence for print quality test pages, as indicated on the printer settings configuration sheet.
6. Press and hold until all lights cycle.
After a few minutes, the print quality test pages print. The pages include:

- An information page containing information about the device, the cartridge, margin settings, and minimum stroke width, and a graphic for evaluating the print quality
- Two pages for assessing how well the printer is capable of printing various types of graphics

Examine the pages to determine the quality of printing. If there are problems, see “Solving print quality problems” on page 115.

To return to the Home menu, press and hold \( \times \) until all the lights cycle. To exit the menus, turn the printer off.

**Blank pages**

Try one or more of the following:

- Remove and reinstall the toner cartridge.
- Remove and reinstall the photoconductor kit.

If the printer still prints blank pages, it may need to be serviced. For more information, contact Customer Support.

**Characters have jagged or uneven edges**

If you are using downloaded fonts, verify that the fonts are supported by the printer, the host computer, and the software program.

**Clipped images**

These are possible solutions. Try one or more of the following:

**Che[ck the paper guides**

Move the guides in the tray to the correct positions for the paper size loaded.
CHECK THE PAPER SIZE SETTING

Make sure the Paper Size setting matches the paper loaded in the tray.

Gray background

From the Quality menu, select a reduced Toner Darkness setting before sending the job to print. To access the Quality menu, do one of the following:

- If the printer is on a network, access the Embedded Web Server by typing the printer IP address into the address field of your Web browser. From the Settings tab, click Print Settings.
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.

Ghost images

These are possible solutions. Try one or more of the following:

THE PHOTOCONDUCTOR KIT MAY BE DEFECTIVE

Replace the photoconductor kit.

CHECK THE PAPER SIZE AND PAPER TYPE SETTINGS

From the Paper menu, change the paper size and paper type settings to match the paper loaded in the tray. To access the Paper menu, do one of the following:

- If the printer is on a network, access the Embedded Web Server by typing the printer IP address in the address field of your Web browser. From the Settings tab, click Paper Menu.
- If the printer is connected to a computer by a USB or parallel cable, open the Local Printer Settings Utility for Windows or Printer Settings for Macintosh. One of these utilities installs with the printer software.
Incorrect margins

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING
Make sure the Paper Size setting matches the paper loaded in the tray.

CHECK THE PAGE SIZE SETTING
Before sending the job to print, specify the correct page size in Print Properties or the software program.

Paper curl
These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING
Make sure the Paper Type setting matches the paper loaded in the tray.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
Try one or more of the following:
- Load paper from a fresh package.
- Store paper in its original wrapper until you use it.

Print is too dark
These are possible solutions. Try one or more of the following:
CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too dark, the Brightness setting is too dark, or the Contrast setting is too high.

- From Print Properties, change these settings.

  Note: This solution applies to Windows users only.
- From the Quality menu, change these settings.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

- Load paper from a fresh package.
- Store paper in its original wrapper until you use it.

CHECK THE PAPER

Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING

Make sure the Paper Type setting matches the paper loaded in the tray.

THE TONER CARTRIDGE MAY BE DEFECTIVE

Replace the toner cartridge.

Print is too light

These are possible solutions. Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too light, the Brightness setting is too light, or the Contrast setting is too low.

- From Print Properties, change these settings.

  Note: This solution applies to Windows users only.
- From the Quality menu, change these settings.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

- Load paper from a fresh package.
- Store paper in its original wrapper until you use it.
CHECK THE PAPER
Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING
Make sure the Paper Type setting matches the paper loaded in the tray.

THE TONER MAY BE LOW
When Toner is low appears on the virtual display, or when the print becomes faded, order a new toner cartridge.

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

Skewed print

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER
Make sure you are using paper that meets the printer specifications.

Toner fog or background shading appears on the page
These are possible solutions. Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Toner rubs off

These are possible solutions. Try one or more of the following:
CHECK THE PAPER TYPE setting
Make sure the Paper Type setting matches the paper loaded in the tray.

CHECK THE PAPER TEXTURE setting
Make sure the Paper Texture setting matches the paper loaded in the tray.

Toner specks

These are possible solutions. Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Transparency print quality is poor

CHECK THE TRANSPARENCIES
Use only transparencies recommended by the printer manufacturer.

CHECK THE PAPER TYPE setting
Load transparencies, and make sure the Paper Type setting is set to Transparency.

Streaked horizontal lines
These are possible solutions. Try one or more of the following:

**THE TONER IS SMEARED**

Select another tray or feeder to feed the paper for the job:
- From the printer control panel Paper Menu, select the Default Source.
- For Windows users, select the paper source from Print Properties.
- For Macintosh users, select the paper source from the Print dialog and pop-up menus.

**THE TONER CARTRIDGE MAY BE DEFECTIVE**

Replace the toner cartridge.

**THE PAPER PATH MAY NOT BE CLEAR**

Check the paper path around the toner cartridge.

⚠️ **CAUTION—HOT SURFACE:** The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow the surface to cool before touching.

Clear any paper you see.

**THERE IS TONER IN THE PAPER PATH**

Contact Customer Support.

**Streaked vertical lines**

These are possible solutions. Try one or more of the following:

**THE TONER IS SMEARED**

Select another tray or feeder to feed paper for the job:
- From the printer control panel Paper Menu, select the Default Source.
- For Windows users, select the paper source from Print Properties.
- For Macintosh users, select the paper source from the Print dialog and pop-up menus.

**THE TONER CARTRIDGE IS DEFECTIVE**

Replace the toner cartridge.
THE PAPER PATH MAY NOT BE CLEAR

Check the paper path around the toner cartridge.

⚠️ CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot component, allow the surface to cool before touching.

Clear any paper you see.

THERE IS TONER IN THE PAPER PATH

Contact Customer Support.

Solid black or white streaks appear on transparencies or paper

These are possible solutions. Try one or more of the following:

MAKE SURE THE FILL PATTERN IS CORRECT

If the fill pattern is incorrect, choose a different fill pattern from your software program.

CHECK THE PAPER TYPE

- Try a different type of paper.
- For transparencies, use only ones recommended by the printer manufacturer.
- Make sure the Paper Type setting matches what is loaded in the tray or feeder.
- Make sure the Paper Texture setting is correct for the type of paper or specialty media loaded in the tray or feeder.

MAKE SURE THE TONER IS DISTRIBUTED EVENLY IN THE TONER CARTRIDGE

Remove the toner cartridge and shake it from side to side to redistribute the toner to extend the life of the cartridge, and then reinstall it.

THE TONER CARTRIDGE MAY BE DEFECTIVE OR LOW ON TONER

Replace the used toner cartridge with a new one.
Contacting Customer Support

When you call Customer Support, describe the problem you are experiencing, the message on the display, and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label on the inside top front cover of the printer. The serial number is also listed on the menu settings page.

In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit the Lexmark Web site at http://support.lexmark.com.
Notices

Product information

Product name:
Lexmark E260, E260d, E260dn

Machine type:
4513

Model(s):
200, 220, 230

Edition notice

February 2011

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

If you don’t have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2010 Lexmark International, Inc.

All rights reserved.
UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer software and documentation developed exclusively at private expense.

Trademarks

Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc., registered in the United States and/or other countries.

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.

PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a set of printer commands (language) and functions included in its printer products. This printer is intended to be compatible with the PCL language. This means the printer recognizes PCL commands used in various application programs, and that the printer emulates the functions corresponding to the commands.

All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user’s authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device, use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000
**Modular component notice**

Wireless-equipped models contain the following modular component(s):

Lexmark regulatory type/model LEX-M04-001; FCC ID:IYLLEXM04001; IC:2376A-M04001

**Noise emission levels**

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

**Note:** Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>1-meter average sound pressure, dBA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
</tr>
<tr>
<td>Ready</td>
</tr>
</tbody>
</table>

Values are subject to change. See [www.lexmark.com](http://www.lexmark.com) for current values.

**Waste from Electrical and Electronic Equipment (WEEE) directive**

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the Lexmark Web site at [www.lexmark.com](http://www.lexmark.com) for your local sales office phone number.

**Static sensitivity notice**

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the metal frame of the printer.
ENERGY STAR

Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Temperature information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>15.6°C – 32.2°C</td>
</tr>
<tr>
<td>Shipping and storage temperature</td>
<td>-40.0°C – 60.0°C</td>
</tr>
</tbody>
</table>

Laser notice

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for Class I (1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system and printer are designed so there is never any human access to laser radiation above a Class I level during normal operation, user maintenance, or prescribed service condition.

Laser advisory label

A laser notice label may be affixed to this printer as shown:
Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Power consumption (Watts)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>The product is generating hard-copy output from electronic inputs.</td>
<td>470 W</td>
</tr>
<tr>
<td>Copying</td>
<td>The product is generating hard-copy output from hard-copy original documents.</td>
<td>N/A</td>
</tr>
<tr>
<td>Scanning</td>
<td>The product is scanning hard-copy documents.</td>
<td>N/A</td>
</tr>
<tr>
<td>Ready</td>
<td>The product is waiting for a print job.</td>
<td>12 W</td>
</tr>
<tr>
<td>Power Saver</td>
<td>The product is in energy-saving mode.</td>
<td>11 W</td>
</tr>
<tr>
<td>Off</td>
<td>The product is plugged into a wall outlet, but the power switch is turned off.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.

Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity. The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the Power Saver Timeout.

Factory default Power Saver Timeout for this product (in minutes): 30 min.

By using the configuration menus, the Power Saver Timeout can be modified between 1 minute and 240 minutes. Setting the Power Saver Timeout to a low value reduces energy consumption, but may increase the response time of the product. Setting the Power Saver Timeout to a high value maintains a fast response, but uses more energy.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power consumption, disconnect the power supply cord from the wall outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode’s energy usage.
Industry Canada compliance statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard ICES-003.

Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements pouvant causer des interférences NMB-003.

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC and 2006/95/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility and safety of electrical equipment designed for use within certain voltage limits.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA. The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products
This section contains the following regulatory information pertaining to wireless products that contain transmitters, for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation
The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.
The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical specifications were met.

**Industry Canada (Canada)**

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme aux spécifications techniques d'Industry Canada.

**Notice to users in the European Union**

Products bearing the CE mark are in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio equipment and telecommunications terminal equipment.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA. The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the
Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio equipment and telecommunications terminal equipment.

Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA. The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon request from the Authorized Representative.

<table>
<thead>
<tr>
<th>Language</th>
<th>Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Česky</td>
<td>Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.</td>
</tr>
<tr>
<td>Dansk</td>
<td>Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
<tr>
<td>Ελληνική</td>
<td>ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.</td>
</tr>
<tr>
<td>English</td>
<td>Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.</td>
</tr>
<tr>
<td>Español</td>
<td>Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Eesti</td>
<td>Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.</td>
</tr>
<tr>
<td>Français</td>
<td>Par la présente, Lexmark International, Inc. déclare que l’appareil ce produit est conforme aux exigences fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.</td>
</tr>
<tr>
<td>Magyar</td>
<td>Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvető követelményeknek és az 1999/5/EC irányelv egyéb előírásainak.</td>
</tr>
<tr>
<td>Íslenska</td>
<td>Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar kröfur, sem gerðar eru í tilskipun 1999/5/EC.</td>
</tr>
<tr>
<td>Italiano</td>
<td>Con la presente Lexmark International, Inc. dichiara che questo prodotto è conforme ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.</td>
</tr>
<tr>
<td>Latviski</td>
<td>Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EEK būtiskajām prasībām un citiem ar to saistītajiem noteikumiem.</td>
</tr>
</tbody>
</table>
Statement of Limited Warranty
Lexmark E260, E260d, E260dn

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty
Lexmark warrants that this product:
—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts
—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair or replacement (at Lexmark’s option).

If this product is a feature or option, this statement applies only when that feature or option is used with the product for which it was intended. To obtain warranty service, you may be required to present the feature or option with the product.

If you transfer this product to another user, warranty service under the terms of this statement is available to that user for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that user.

Limited warranty service
The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later provided that the warranty period for any supplies and for any maintenance items included with the printer shall end earlier if it, or its original contents, are substantially used up, depleted, or consumed.
To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location. You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions, liens, and encumbrances.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact Lexmark on the World Wide Web at http://support.lexmark.com.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered by a Lexmark warranty, technical support may not be available or only be available for a fee.

**Extent of limited warranty**

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments
—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance
—Unsuitable physical or operating environment
—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer
—Operation of a product beyond the limit of its duty cycle
—Use of printing media outside of Lexmark specifications
—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts
—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES, AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

**Limitation of liability**

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual damages up to the limit set forth in the following paragraph.
Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real property or tangible personal property for which Lexmark is legally liable. **IN NO EVENT WILL LEXMARK BE LIABLE FOR ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.** This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended beneficiaries of this limitation.

**Additional rights**

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

**LEXMARK SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT**

PLEASE READ CAREFULLY BEFORE USING THIS PRODUCT: BY USING THIS PRODUCT, YOU AGREE TO BE BOUND BY ALL THE TERMS AND CONDITIONS OF THIS SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS OF THIS SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT, PROMPTLY RETURN THE PRODUCT UNUSED AND REQUEST A REFUND OF THE AMOUNT YOU PAID. IF YOU ARE INSTALLING THIS PRODUCT FOR USE BY OTHER PARTIES, YOU AGREE TO INFORM THE USERS THAT USE OF THE PRODUCT INDICATES ACCEPTANCE OF THESE TERMS.

**LEXMARK SOFTWARE LICENSE AGREEMENT**

This License Agreement ("Software License Agreement") is a legal agreement between you (either an individual or a single entity) and Lexmark International, Inc. ("Lexmark") that, to the extent your Lexmark product or Software Program is not otherwise subject to a written software license agreement between you and Lexmark or its suppliers, governs your use of any Software Program installed on or provided by Lexmark for use in connection with your Lexmark product. The term "Software Program" includes machine-readable instructions, audio/visual content (such as images and recordings), and associated media, printed materials and electronic documentation, whether incorporated into, distributed with or for use with your Lexmark product.

1 **STATEMENT OF SOFTWARE LIMITED WARRANTY.** Lexmark warrants that the media (e.g., diskette or compact disk) on which the Software Program (if any) is furnished is free from defects in materials and workmanship under normal use during the warranty period. The warranty period is ninety (90) days and commences on the date the Software Program is delivered to the original end-user. This limited warranty applies only to Software Program media purchased new from Lexmark or an Authorized Lexmark Reseller or Distributor. Lexmark will replace the Software Program should it be determined that the media does not conform to this limited warranty.

2 **DISCLAIMER AND LIMITATION OF WARRANTIES.** EXCEPT AS PROVIDED IN THIS SOFTWARE LICENSE AGREEMENT AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, LEXMARK AND ITS SUPPLIERS PROVIDE THE SOFTWARE PROGRAM "AS IS" AND HEREBY DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ABSENCE OF VIRUSES, ALL WITH REGARD TO THE SOFTWARE PROGRAM. TO THE EXTENT LEXMARK CANNOT BY LAW DISCLAIM ANY COMPONENT OF THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, LEXMARK LIMITS THE DURATION OF SUCH WARRANTIES TO THE 90-DAY TERM OF THE EXPRESS SOFTWARE LIMITED WARRANTY.
This Agreement is to be read in conjunction with certain statutory provisions, as that may be in force from time to time, that imply warranties or conditions or impose obligations on Lexmark that cannot be excluded or modified. If any such provisions apply, then to the extent Lexmark is able, Lexmark hereby limits its liability for breach of those provisions to one of the following: providing you a replacement copy of the Software Program or reimbursement of the price paid for the Software Program.

The Software Program may include internet links to other software applications and/or internet web pages hosted and operated by third parties unaffiliated with Lexmark. You acknowledge and agree that Lexmark is not responsible in any way for the hosting, performance, operation, maintenance, or content of, such software applications and/or internet web pages.

3 LIMITATION OF REMEDY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ANY AND ALL LIABILITY OF LEXMARK UNDER THIS SOFTWARE LICENSE AGREEMENT IS EXPRESSLY LIMITED TO THE GREATER OF THE PRICE PAID FOR THE SOFTWARE PROGRAM AND FIVE U.S. DOLLARS (OR THE EQUIVALENT IN LOCAL CURRENCY). YOUR SOLE REMEDY AGAINST LEXMARK IN ANY DISPUTE UNDER THIS SOFTWARE LICENSE AGREEMENT SHALL BE TO SEEK TO RECOVER ONE OF THESE AMOUNTS, UPON PAYMENT OF WHICH LEXMARK SHALL BE RELEASED AND DISCHARGED OF ALL FURTHER OBLIGATIONS AND LIABILITY TO YOU.

IN NO EVENT WILL LEXMARK, ITS SUPPLIERS, SUBSIDIARIES, OR RESELLERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO LOST PROFITS OR REVENUES, LOST SAVINGS, INTERRUPTION OF USE OR ANY LOSS OF, INACCURACY IN, OR DAMAGE TO, DATA OR RECORDS, FOR CLAIMS OF THIRD PARTIES, OR DAMAGE TO REAL OR TANGIBLE PROPERTY, FOR LOSS OF PRIVACY ARISING OUT OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE PROGRAM, OR OTHERWISE IN CONNECTION WITH ANY PROVISION OF THIS SOFTWARE LICENSE AGREEMENT), REGARDLESS OF THE NATURE OF THE CLAIM, INCLUDING BUT NOT LIMITED TO BREACH OF WARRANTY OR CONTRACT, TORT (INCLUDING NEGLIGENCE OR STRICT LIABILITY), AND EVEN IF LEXMARK, OR ITS SUPPLIERS, AFFILIATES, OR REMARKETERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY YOU BASED ON A THIRD-PARTY CLAIM, EXCEPT TO THE EXTENT THIS EXCLUSION OF DAMAGES IS DETERMINED LEGALLY INVALID. THE FOREGOING LIMITATIONS APPLY EVEN IF THE ABOVE-STATED REMEDIES FAIL OF THEIR ESSENTIAL PURPOSE.

4 U.S.A. STATE LAWS. This Software Limited Warranty gives you specific legal rights. You may also have other rights that vary from state to state. Some states do not allow limitations on how long an implied warranty lasts or the exclusion of limitation of incidental or consequential damages, so the above limitations may not apply to you.

5 LICENSE GRANT. Lexmark grants you the following rights provided you comply with all terms and conditions of this License Agreement:

a Use. You may Use one (1) copy of the Software Program. The term “Use” means storing, loading, installing, executing, or displaying the Software Program. If Lexmark has licensed the Software Program to you for concurrent use, you must limit the number of authorized users to the number specified in your agreement with Lexmark. You may not separate the components of the Software Program for use on more than one computer. You agree that you will not Use the Software Program, in whole or in part, in any manner that has the effect of overriding, modifying, eliminating, obscuring, altering or de-emphasizing the visual appearance of any trademark, trade name, trade dress or intellectual property notice that appears on any computer display screen normally generated by, or as a result of, the Software Program.

b Copying. You may make one (1) copy of the Software Program solely for purposes of backup, archiving, or installation, provided the copy contains all of the original Software Program’s proprietary notices. You may not copy the Software Program to any public or distributed network.

c Reservation of Rights. The Software Program, including all fonts, is copyrighted and owned by Lexmark International, Inc. and/or its suppliers. Lexmark reserves all rights not expressly granted to you in this License Agreement.

d Freeware. Notwithstanding the terms and conditions of this License Agreement, all or any portion of the Software Program that constitutes software provided under public license by third parties (“Freeware”) is licensed to you subject to the terms and conditions of the software license agreement accompanying such Freeware, whether in the form of a discrete agreement, shrink-wrap license, or electronic license terms at the
time of download. Use of the Freeware by you shall be governed entirely by the terms and conditions of such license.

6 TRANSFER. You may transfer the Software Program to another end-user. Any transfer must include all software components, media, printed materials, and this License Agreement and you may not retain copies of the Software Program or components thereof. The transfer may not be an indirect transfer, such as a consignment. Prior to the transfer, the end-user receiving the transferred Software Program must agree to all these License Agreement terms. Upon transfer of the Software Program, your license is automatically terminated. You may not rent, sublicense, or assign the Software Program except to the extent provided in this License Agreement, and any attempt to do so shall be void.

7 UPGRADES. To Use a Software Program identified as an upgrade, you must first be licensed to the original Software Program identified by Lexmark as eligible for the upgrade. After upgrading, you may no longer use the original Software Program that formed the basis for your upgrade eligibility.

8 LIMITATION ON REVERSE ENGINEERING. You may not alter, decrypt, reverse engineer, reverse assemble, reverse compile or otherwise translate the Software Program, except as and to the extent expressly permitted to do so by applicable law for the purposes of inter-operability, error correction, and security testing. If you have such statutory rights, you will notify Lexmark in writing of any intended reverse engineering, reverse assembly, or reverse compilation. You may not decrypt the Software Program unless necessary for the legitimate Use of the Software Program.

9 ADDITIONAL SOFTWARE. This License Agreement applies to updates or supplements to the original Software Program provided by Lexmark unless Lexmark provides other terms along with the update or supplement.

10 TERM. This License Agreement is effective unless terminated or rejected. You may reject or terminate this license at any time by destroying all copies of the Software Program, together with all modifications, documentation, and merged portions in any form, or as otherwise described herein. Lexmark may terminate your license upon notice if you fail to comply with any of the terms of this License Agreement. Upon such termination, you agree to destroy all copies of the Software Program together with all modifications, documentation, and merged portions in any form.

11 TAXES. You agree that you are responsible for payment of any taxes including, without limitation, any goods and services and personal property taxes, resulting from this Agreement or your Use of the Software Program.

12 LIMITATION ON ACTIONS. No action, regardless of form, arising out of this Agreement may be brought by either party more than two years after the cause of action has arisen, except as provided under applicable law.

13 APPLICABLE LAW. This Agreement is governed by the laws of the Commonwealth of Kentucky, United States of America. No choice of law rules in any jurisdiction shall apply. The UN Convention on Contracts for the International Sale of Goods shall not apply.

14 UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Software Program has been developed entirely at private expense. Rights of the United States Government to use the Software Program is as set forth in this Agreement and as restricted in DFARS 252.227-7014 and in similar FAR provisions (or any equivalent agency regulation or contract clause).

15 CONSENT TO USE OF DATA. You agree that Lexmark, its affiliates, and agents may collect and use information you provide in relation to support services performed with respect to the Software Program and requested by you. Lexmark agrees not to use this information in a form that personally identifies you except to the extent necessary to provide such services.

16 EXPORT RESTRICTIONS. You may not (a) acquire, ship, transfer, or reexport, directly or indirectly, the Software Program or any direct product therefrom, in violation of any applicable export laws or (b) permit the Software Program to be used for any purpose prohibited by such export laws, including, without limitation, nuclear, chemical, or biological weapons proliferation.

17 AGREEMENT TO CONTRACT ELECTRONICALLY. You and Lexmark agree to form this License Agreement electronically. This means that when you click the “Agree” or “Yes” button on this page or use this product, you acknowledge your agreement to these License Agreement terms and conditions and that you are doing so with the intent to “sign” a contract with Lexmark.
18 **CAPACITY AND AUTHORITY TO CONTRACT.** You represent that you are of the legal age of majority in the place you sign this License Agreement and, if applicable, you are duly authorized by your employer or principal to enter into this contract.

19 **ENTIRE AGREEMENT.** This License Agreement (including any addendum or amendment to this License Agreement that is included with the Software Program) is the entire agreement between you and Lexmark relating to the Software Program. Except as otherwise provided for herein, these terms and conditions supersede all prior or contemporaneous oral or written communications, proposals, and representations with respect to the Software Program or any other subject matter covered by this License Agreement (except to the extent such extraneous terms do not conflict with the terms of this License Agreement, any other written agreement signed by you and Lexmark relating to your Use of the Software Program). To the extent any Lexmark policies or programs for support services conflict with the terms of this License Agreement, the terms of this License Agreement shall control.

**MICROSOFT CORPORATION NOTICES**

1. This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369.

2. This product is based on Microsoft Print Schema technology. You may find the terms and conditions upon which Microsoft is licensing such intellectual property at http://go.microsoft.com/fwlink/?LinkId=83288.

**ADOBE SYSTEMS INCORPORATED NOTICE**

Contains Flash®, Flash® Lite™ and/or Reader® technology by Adobe Systems Incorporated

This Product contains Adobe® Flash® player software under license from Adobe Systems Incorporated, Copyright © 1995-2007 Adobe Macromedia Software LLC. All rights reserved. Adobe, Reader and Flash are trademarks of Adobe Systems Incorporated.
Index

Numerics
202 paper jams, clearing
  behind the rear door 105
235 paper jams, clearing
  from standard exit bin 101
250-sheet drawer
  installing 19
251 paper jams, clearing
  from manual feeder 104
2-sided printing 57
31 Defective cartridge 108
32.yy Replace unsupported
cartridge 108
550-sheet drawer
  installing 19
58 Too many flash options
  installed 108
58 Too many trays attached 109
59 Incompatible tray <x> 109
88 Replace toner 109

A
attaching cables 22

B
booklet
  printing 62
both sides of paper (duplexing)
  printing manually 57

C
cables
  Ethernet 22
  parallel 22
  USB 22
calling Customer Support 124
canceling a job
  from Macintosh 64
  from the printer control panel 64
card stock
  tips 61
checking an unresponsive
printer 109
cleaning
  exterior of the printer 84
Close front door 107
collate setting
  Finishing menu 67
calculations
  printer 11
conserving supplies 26
contacting Customer Support 124
counting panel, printer 36
buttons 14
lights 14
Custom Types menu 73

D
Default Source menu 68
documents, printing
  from Macintosh computer 56
  from Windows 56
duplex printing 57
  manual 57

E
Embedded Web Server
  administrator settings 93
  networking settings 93
Embedded Web Server
Administrator’s Guide 93
emission notices 126, 127, 130, 131
envelopes
  loading 46
tips 60
environmental settings 26
Ethernet port 22
exterior of the printer
  cleaning 84
factory defaults, restoring
  using Printer Settings 93
  using the Local Printer Settings
    Utility 93
  using the printer control panel 93
FCC notices 126, 130
finding
  information 9
  publications 9
Web site 9
Finishing menu 78
  using 67

G
General settings menu 75
guidelines
  letterhead 59

I
information, finding 9
installing
  options in driver 24
  printer software 23
installing printer software
  adding options 24
  installing software
    Local Printer Settings Utility 66

J
jam
  light sequences 95
  messages 95
jam recovery
  setting 65
jams
  accessing jam areas 94
  avoiding 94
  jams, clearing
    200 99, 101
    201 99, 101
    233 103
  behind photoconductor kit and
toner cartridge unit 99
  behind the rear door 105
  from manual feeder 104
  from standard exit bin 101
  from standard tray 101
  from Tray 1 101
  from Tray 2 103

L
labels, paper
  tips 61
letterhead
guidelines 59
loading, manual feeder 59
loading, trays 59
light sequences
  on printer control panel 36
secondary error 36

Index
139
Index

140
incorrect margins 118
job prints from wrong tray 111
job prints on wrong paper 111
job takes longer than expected 111
jobs do not print 110
Large jobs do not collate 112
multiple-language PDFs do not print 111
paper curl 118
paper frequently jams 114
tray linking does not work 112
printer
  basic model 11
  configurations 11
  minimum clearances 10
  moving 91
  selecting a location 10
  shipping 92
printer control panel 36
  buttons 14
  lights 14
printer messages
  31 Defective cartridge 108
  32.yy Replace unsupported cartridge 108
  58 Too many flash options installed 108
  58 Too many trays attached 109
  59 Incompatible tray <x> 109
  88 Replace toner 109
  Close front door 107
Load <input src> with <custom string> 107
Load <input src> with <custom type name> 107
Load <input src> with <size> 107
Load <input src> with <type> <size> 107
Load manual feeder with <custom string> 108
Load manual feeder with <custom type name> 108
Load manual feeder with <type> <size> 107
Remove paper from standard output bin 108
printer options troubleshooting
drawers 113
memory card 114
option not working 113
printer problems, solving basic 109
printer settings configuration sheet
printing 22
printing
  booklet 62
duplex (2-sided) 57
duplex, manual 57
from Macintosh computer 56
from Windows 56
installing printer software 23
menu settings page 62
network setup page 62
on both sides of paper
  manually 57
  on both sides of the paper 57
print quality test pages 63, 115
publications, finding 9
Q
  Quality menu 80
R
  recycled paper
    using 26
  recycling
    Lexmark packaging 28
    Lexmark products 28
toner cartridges 28
  WEEE statement 127
Remove paper from standard output bin 108
reprint page
  after paper jam 65
S
  safety information 7, 8
  separator sheet setting
    Finishing menu 67
  setting
    paper size 40
    paper type 40
  Universal Paper Size 40
Setup menu 77
shipping the printer 92
Size/Type menu 68
standard 250-sheet tray
  loading 40
standard exit bin, using 47
status of supplies, checking 84
  storing
    paper 52
    supplies 84
supplies
  conserving 26
  status of 84
  storing 84
  supplies, ordering
    photoconductor kit 86
toner cartridges 85
system board
  accessing 16
T
tips
  card stock 61
  envelopes 60
  labels, paper 61
  transparencies 60
toner cartridges
  ordering 85
  recycling 28
transparencies
tips 60
trays
  linking 48
  unlinking 48
troubleshooting
  checking an unresponsive printer 109
  contacting Customer Support 124
  solving basic printer problems 109
troubleshooting, paper feed
  lights remain on after jam is cleared 114
  page that jammed does not reprint 115
troubleshooting, print
  incorrect characters print 112
  incorrect margins 118
  job prints from wrong tray 111
  job prints on wrong paper 111
  job takes longer than expected 111
  jobs do not print 110
  Large jobs do not collate 112
  multiple-language PDFs do not print 111
  paper curl 118
  paper frequently jams 114
  tray linking does not work 112
  troubleshooting, print quality
    blank pages 116
  characters have jagged edges 116
clipped images 116
ghost images 117
gray background 117
poor transparency quality 121
print is too dark 118
print is too light 119
skewed print 120
solid black streaks 123
solid white streaks 123
streaked horizontal lines 121
streaked vertical lines 122
toner fog or background shading 120
toner rubs off 120
toner specks 121
troubleshooting, printer options
  drawers 113
  memory card 114
  option not working 113

U
Universal Paper Size  74
  setting  40
Universal Setup menu  74
unlinking trays  48
USB port  22

W
Web site
  finding  9